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Forward 

I 

What is the Manufactured Home Energy Audit? 
The Manufactured Home Energy Audit (MHEA) is a software tool that predicts 
mandactured home energy consumption and recommends weatherization retrofit 
measures. It was developed to assist local weatherization agencies working with the 
U.S. Department of Energy (DOE) Weatherization Assistance Program. Whether 
new or experienced, employed within or outside the Weatherization Assistance 
Program, all users can benefit from incorporating MHEA into their man&actured 
home weatherization programs. DOE anticipates that the state weatherization 
assistance programs that incorporate MHEA into their programs will find significant 
growth in the energy and cost savings achieved from manufactured home 
weatherization. 
The easy-to-use MHEA displays a colorful, graphical interface for entering simple 
inputs and provides understandable, usable results. The user enters information about 
the manufactured home construction, heating equipment, cooling equipment, and 
weather site. MHEA then calculates annual energy consumption using a simplified 
building energy analysis technique. Weatherization retrofit measures are evaluated 
based on the predicted energy savings after installation of the measure, the measure 
cost, and the measure life. Finally, MHEA recommends retrofit measures that are 
energy and cost effective for the particular home being evaluated. 
MHEA evaluates each manufactured home individually and takes into account local 
weather conditions, retrofit m e m e  costs, and fuel costs. The recommended package 
of weatheIization retrofit measures is tailored to the home being evaluated. More 
traditional techniques apply the same package of retrofit measures to all 
manufactured homes, often the same set of measures that are installed into site-built 
homes. Effective manufactured home weatherization can be achieved only by 
installing measures developed specifically for manufactured homes. The unique 
manufactured home construction characteristics require that each of these measures is 
evaluated separately in order to devise a package of measures that will result in high 
energy and dollar savings. 
MKEA stands apart fiom other building energy analysis tools in many ways. 
Calculations incorporated into the computer code specifically address manufactured 
home heating and cooling load trends. The retrofit measures evaluated by MHEA are 
all applicable to manufactured homes. Help messages describe common 
manufactured home weatherization practices as well as provide hints on how to install 
retrofit measures. These and other features help make MEiEA easy to use when 
evaluating energy consumption and the effects of weatherization retrofit measures for 
manufactured homes. 
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. The National Renewable Energy Laboratory has developed MHEA for the U.S. 
Department of Energy Weatherization Assistance Program. Many energy 
consumption and economic calculations resemble those found in the Computerized 
Instrumented Residential Audit written by Lawrence Berkeley National Laboratory 
and the National Energy Audit written by Oak Ridge National Laboratory. The 
calculations are similar in structure but have been altered to more accurately represent 
manufactured home unique energy use characteristics. Most importantly, MHEA 
helps meet the DOE Weatherization Assistance Program goals to increase client 
comfort and use federal dollars wisely. 
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Parameters 

1. 

Orienting the User 
MHEA has five main components: file, inputs, run, view, and setup. These 
components are also listed as the main menu items displayed at the top of all MHEA 
screens. Project files (where information about the manufactured homes that you are 
evaluating is stored in the computer memory) are managed by using the options 
available within the File menu. You may create new project files, open existing 
project files, copy or delete project files, and print project file inputs and results. 
All data describing the manufactured home construction and heatinglcooling 
equipment are entered within the Inputs menu. You may also enter general 
comments and utility bill data under the Inputs menu. 
Choose one of the options within the Run menu to activate MHEA calculations. You 
may evaluate the manufactured home energy consumption and effects of installing 
retrofit measure either with or without adjusting the results according to utility bill 
data. 
After you have run the calculations, display the results by selecting one of the options 
under the View menu. The comments and a summary of the input data are also 
displayed by selecting the appropriate View menu options. 
Finally, you may select a weather location, adjust the default values displayed on the 
input screens and used in ME-IEA calculations, specify retrofit measure and fuel costs, 
and determine which retrofit measures will be evaluated by revising the parameters 
included with the Setup menu options. 

MHEA Flow Chart 

CDRH07-AO342503 
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Quick Start 
Install MHEA onto your computer by following the directions outlined below. More 
detailed information for installing MHEA is given in Section 1.2, Installing MHEA. 
Your computer must be an BM@ or compatible computer with an  80286 or higher 
processor to run MHEA. Your hard drive must have at least 2 MB (5 MB suggested) 
of available space, and your computer must have at least 640K of RAM. The video 
display must be VGA, and you must be using MS-DOS@ version 4.2 or later. 
To install MHEA, insert the MHEA diskette into either the A or B: drive and type 
the commands listed below. Then follow the instructions that appear on your screen. 

C: <Em- 
a:\installa <ENTER> if installing from the A: drive 
b:\installb <ENTER> if installing from the B: drive 

If you have a previous version of MHEA installed on your computer, either remove 
that version from your computer or install the new version into a separate directory. 
Refer to Section 1.2.2, Reinstalling MHEA, and Section 1.2.3, Installing =A into 
Nondefault Directories. 
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1 .O Getting 
Started 

In the Getting Started chapter you will learn about the computer equipment you will 
need, how to install the software, and how to move through MHEA. This chapter is 
especially useful if you are unfamiliar with MHEA or if you are new to using computers. 

1 .I 

1 .I .1 

1.1.2 

Equipment You Will Need 
To use MHEA, you will need at a minimum the equipment listed in section 1.1.1, 
Minimum Requirements. Section 1.1.2, Recommended Requirements, lists 
recommended equipment that will help make using MHEA easier for you. 

Minimum Requirements 
Computer - BM@ or compatible computer with an 80286 processor or 
higher 
Hard Disk Drive - hard disk with at least 2 MI3 (5 MB suggested) of 
available space 

Floppy Disk Drive 
Memory - at least 640K of RAM 
Video Display - VGA monitor (640 x 480 pixel resolution) 

Operating System - MS-DOS@ version 4.2 or later 

Recommended Requirements 
Mouse - a Microsoft Mouse or compatible mouse is highly recommended 
Printer - MHEA is compatible with many common printer types 

1.2 Installing MHEA 
This section describes how to install MHEA, both onto computers where you 
have not previously installed the software (Section 1.2.1) and onto computers 
where an older version of the sohare.already exists (Section 1.2.2). You will 
also learn how to install MHEA into non-default directories. 

1.2.1 Installing MHEA for the First Time 

If you are installing MHEA onto a computer that does not already have an 
existing version of the software on it, follow the instructions for installing MHEA 
for the first time. 

Getting Started 1 
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Note Check if MHEA has been installed onto your computer by typing at 
the c:\ prompt 

dir/s mhea.exe a m m  
To install MHEA for the first time 
1. Access the hard drive on which you want to load the software. Usually this is 

the C drive. If a prompt such as C:\ is not on your screen, type 
C: <ENTER> 

Note If a prompt such as C:\<directory name> appears on your screen, type 
the following command to reduce the prompt back to just C:l 

cd c:\ (ENTER> 

Warning Do not install MHEA until you see the appropriate directory 
name at the C prompt. If a prompt such as C:\<directory name> 
is on your screen when you initiate the installation procedure, 
you will install MHEA into the MS-DOS@ directory whose name 
is indicated by the prompt. 

Note Refer to section 1.2.3, Installing MHEA onto Nondefault Directories, 
for directions on how to install MHEA into a directory other than the 
MHEA default directory. 

2. Insert MHEA diskette into the floppy disk drive on your computer. Be sure to 
note if you are installing the software from your A: or B: floppy disk drive. 

3. Type one of the commands listed below depending on which drive you are 
using to install MHEA. 

If you are installing MHEA from the A. drive, type 
a:\installa amR> 

If you are installing MHEA from the B: drive, type 
b:btallb a N T E € e  

4. The software will now begin creating directories and inflating fdes. 

If you successfully followed all four steps, you have completed installation of 
h4J3EA. 

1.2.2 Reinstalling MHEA 

If you have a previous version of MHEA on your computer, follow the 
instructions for reinstalling MHEA. 

2 Manufactured Home Energy Audit 



Note Check if MHEA has been installed onto your computer by typing at 
the c:\ prompt 

CENTER> dir Is mheaexe 
To reinstall MHEA 
1. Access the hard drive on which a previous version of the MHEA is stored. 

Usually this is the C drive. If a prompt such as C:\ is not on your screen, type 
C: <ENTER> 

Note If a prompt such as C:\<directory name> appears on your screen, type 
the following command to reduce the prompt back to just C:l 

cd c:\ <ENTER> 

Warning Do not install MHEA until you see the appropriate directory 
name at the C prompt. If a prompt such as Ckdirectury name> 
is on your screen when you initiate the installation procedure, 
you will install MHEA into the MS-DOS@ directory whose name 
is indicated by the prompt. 

2. Access the directory where the software is stored. The default directory name 
is MHEA. Type the following command so that a prompt such as C:\MHEA 
appears on your screen. 

cd MHEA CENTEB 

Note If MHEA was installed within a directory, then change to that 
directory before typing the above command. For example, type cd 
directory name> CENTER> so that the prompt C:\<directory name> 
appears on your screen. Now type cd MHEA a m .  (Note that the 
directory name will be an 8 or less character name you previously 
indicated.) The prompt on your screen should now be C:\<directory 
name>\MHEA. 

3. Erase all files in MHEA directory and in the SYSTEM subdirectory (A 
SYSTEM subdirectory is automatically created when you install =A). 
Three methods for completing this task are outlined below. 

Method A. 
At a prompt such as C:\MHEA, type the following commands 
erase *.* 
Y 

cd system 

erase *.* 

C E N T E B  
CENTER> 

CENTEB 

CENTEB 

(answer Yes when you are asked if you wish 
to erase all files in MHEA directory) 

(open the SYSTEM subdirectory and change 
the screen prompt to C:\MHEA\SYSTEM) 
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Y CEN"EB (answer Yes when you are asked if you wish 
to erase all files in MHEAKYSTEM 
directory) 

Warning Be careful that you are erasing files in MHEA directory and not 
fdes in another directory you wish to keep. 

Method B 
If you have Microsoft Windows@ or another utility program on your 
computer, then you can erase files and directories using this software. For 
example, first open the File Manager in Windows 3.1@ (found within the 
Main program group in the Program Manager) or Windows Explorer in 
Windows 950  (found by selecting the Programs menu after clicking onto the 
Start button). Then access the C: drive, highlight MHEA directory found on 
the left half of the screen, and press the Delete key on your computer. Answer 
Okay or yes to all questions that are asked then return to MS-DOS@,. For 
more information, refer to your Microsoft Windows@ user's manual. 

Method C (not available in MS-DOS@ version 5.x and below) 
At a prompt such as C:\MHEA, type the following command 
deltreeMHEA CENTED 
Y CENTER> (to answer Yes when you are asked if you 

wish to erase all files in MHEA directory) 

Warning Be careful to erase files in MHEA directory and not files in 
another directory you wish to keep. The deltree command can be 
dangerous to use unless you are very careful to erase files in the 
correct directory. If the screen prompt is only a single letter such 
as C:! do not use this command. If MHEA directory is not open, 
you could accidentally erase your entire hard drive. 

4. Insert MHEA diskette into the floppy disk drive on your computer. Be sure to 
note if you are installing the software from your A: or B: floppy disk drive. 

5. Type one of the commands listed below depending on from which drive you 
are installing MHEA. 

If you are installing MHEA from the A: drive, type 

a:\instalia CENTEm 

If you are installing MHEA from the B: drive, type 

b:\installb CENTER> 
6. The software will now begin creating directories and inflating files. 

If you successfully followed all six steps, you have completed instalring MHEA. 
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1.2.3 Installing MHEA into Non-default Directories 
If you would like to install MHEA into a directory other than the MHEA default 
directory, complete the following steps. 
1. Create the directory into which you want to install MHEA. From a MS-DOS@ 

prompt such as C:\ type: 
mkdir directory name> CENTED 

Note The directory name must have eight or less characters. 

Note You may also create a directory using a utility software package such 
as Windows@ or Norton Utilities@. Refer to instructions for that 
utility. 

2. Open the directory you just created. Type: 

3. A prompt such as C\cdirectory name> should appear on your screen. Follow 
instructions for installing MHEA for the first time (step 2, Section 1.2.1) or 
reinstalling (step 4, Section 1.2.2) MHEA. 

cd \<directory name> am- 

Warning Do not install MHEA until you see the appropriate directory 
name at the C prompt. If a prompt similar to that shown in step 3 
does not appear on your screen when you begin the installation 
procedure, you will not have installed MHEA into the directory 
that you have just created. 

Note MHEA creates a subdirectory called MHEA within the directory you 
defined. 

1.3 Navigating Through MHEA 
There are four methods for entering data and selecting options within MHEA. It 
is the quickest and easiest to use a mouse. You can also move around the 
software using your keyboard. If you anticipate using MHEA often, it is highly 
recommended that you investigate the opportunities for acquiring a mouse if you 
do not already have one. 

1.3.1 Using Your Mouse 

Once in MHEA, use your mouse to move the black arrow, or pointer, around the 
screen. Point the mow to the menu item, check box, editable field, or button you 
wish to activate. The box will be highlighted (either dark red or black on color 
monitors or solid on mono-color monitors) when the cursor is in the correct 
location. Click the left mouse key to select a menu item, place a check mark, . 



* .  . 

open an editable field, or select a button. Figure 1-1 shows a typical mouse with 
left and right mouse keys. 

Note Refer to Section 1.5, Understanding MHEA Screens, for more 
information about menu items, check boxes, editable fields, buttons, 
and other items. 

Fiagure 1-1 Typical Mouse with Left and Right Keys 

1.3.2 Using Your Keyboard 

There are three keyboard methods for working through MHEA. Although some 
users may prefer to control the cursor using the keyboard instead of the mouse, 
you will probably find that keyboard control requires more time and coordination 
than does using the mouse. 

1.3.2.1 ArT/Letter Key Method (also known as "Hot Keys") 

One letter is underlined in all descriptions for menu items, check boxes, and 
buttons. To select a menu item, place a check mark, or select a button, hold down 
the ALT key at the same time you press the letter that is underlined. To access the 
editable fields, press the ENTER key or the TAB key repeatedly until you have 
placed the cursor in the box you wish to enter a value. Figure 1-2 shows the 
location of the ALT, ENTER, and TAB keys on a typical keyboard. The cursor will 
appear as a blinking short line in the active editable field. 

Note On some computers, the ENTER key may not always work to select 
menu items or activate options. If this occurs, use the ALTbtter key 
method described above instead of the ENTER key to select menu items 
or activate options. 
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Figure 1-2 Typical Keyboard Showing the UT, ENTER, and TAB Keys 

1.3.2.2 ARROW Key Method 

Use the up, down, left, and right -OW keys to move the black arrow on the 
screen to the next menu item, check box, editable field, or button (see Fiape 1-3). 
Press ENTER to select the menu item, place a check mark, or select a button. To 
enter a value in an editable field, point the black arrow to the appropriate editable 
field, press ENTER, and type the input. 

Note On some computers, the ENTER key may not always work to select 
menu items or activate options. If this occurs, use the ALThtter key 
method described above instead of the ENTER key to select menu items 
or activate options. 

h e r n a t e  
key 

a)-RHOfJuI1425m 

Figure 1-3 Typical Keyboard Showing the ALT, ENTER, and m o w  Keys 
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1.3.2.3 SH~FZ~ARROW Meihod 

1.4 

1.4.1 

Note The S H I F T / ~ O W  method is the slowest of the three keyboard 
movement methods. 

Hold the SHIFT key at the same time you hold the ARROW key for the direction you 
want to move the black arrow pointer'on the screen (see Figure 1-4). Move the 
arrow to highlight the menu item, check box, editable field, or button you would 
like to activate. The highlighted item will be either dark red or black on color 
monitors or black on mono-color monitors. Press the ENTER key to select a menu 
item, place a check mark, enter information in an editable field, or select a button. 

Note On some computers, the ENTER key may not always work to select 
menu items or activate options. If this occurs, use the ALThtter key 
method described above instead of the ENTER key to select menu items 
or activate options. 

Lh* key 
keys 

Fiawe 14 Typical Keyboard Showing the ALT, SHIFT, ENTER, and ARROW Keys 

Running MHEA 
In this section, you will learn how to begin using MHEA as well as how to leave 
MHEA and return to MS-DOS@,. 

S€ar€ing MHEA 

In order to enter data, run the calculations, review results, and print projects from 
MHEA, you must first start the software. If the software has been installed onto 
your computer, follow the steps outlined in this section to begin using MHEA. 
1. Access the hard drive on which the software has been installed. Usually this 

is the C drive. If a prompt such as C:\ is not on your screen, type 
C: CENTEB 
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Note If a prompt such as C:\<directory name> appears on your screen, type 
the following command to reduce the prompt back to just C:l 

cd c:\ CENTER> 
2. Access the directory where the software is stored. This directory will be titled 

ME3EA and in most cases will be located on your C drive. Type the following 
command so that a prompt such as C:\MHEA appears on your screen. 

cdmhea <ENTER> 

Note If MHEA was installed within a directory, then open that directory 
before typing the above command. 

3. Start the software by typing the starting command 

4. A "Welcome to MKEAI screen will appear. Refer to Sction 1.4.2, The About 
. Screen, to learn more about the software options that can be accessed from 

this screen. To leave the "Welcome to MHEA" screen and continue using the 
software, select the Continue button. 

mhea <ENTER> 

1.4.2 The About Screen 
The "About" screen provides brief information about MHEA (see Figure 1-5). It 
lets you read instructions on how to use MHEA and perform a preliminary energy 
consumptiodsquare foot/degree-day calculation for the home. This screen 
automatically appears when you begin using MHEA. You may also access it by 
selecting the About submenu option found within the Help main menu item (see 
Section 2.5.2, About). 
At the bottom of the About screen are three buttons. Select the Instructions 
button to display brief instructions on how to move through the software using a 
mouse or the keyboard; enter descriptive data about the manufactured home, then 
evaluate the results calculated by MHEA; print a project file; and' customize 
MHEA using Setup menu options. Because the instructions cannot fit onto one 
screen, you must use the scroll bar on the right side of the screen to view al l  the 
instructions. See Section 1.5.5, Scroll Bars, for information about using this 
feature. Select the Okay button at the bottom of the Instructions screen to leave 
the instructions and return to the About screen. 
The Estimate button allows you to perform an estimate of the home fuel 
consumption per square foot of the home floor area per degree-day (see Figure 1- 
6).  Some users may find this feature useful as a guideline for determining if a 
particular manufactured home consumes sufficient energy to justify 
weatherization. It may also act as an indicator of unusual energy consumption in 
a particuIar manufactured home. 
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Figure 1-5 The "About" Screen 
To calculate an energy use ratio, follow the steps listed below. 

Enter the manufactured home length and width (in feet), the home addition 
length and width (in feet), and the annual energy use (in MBtu). The annual 
energy use may be an estimated value or you may choose to enter an actual 
use based on utility bill data. 
Click on the Select a Weather Site button to pick a city near the location of 
the manufactured home. Refer to section 4.7, Choose a City, for more 
information on how to select a weather site. 
Place a check in the Include Cooling Degree-Day check box if you want the 
energy use ratio to include both heating and cooling degree-days. If only 
heating degree-days are to be included in the energy use ratio, then leave the 
box blank or remove an existing check mark. See section 1.3, Navigating 
Through MHEA, for instructions on how to place and remove check marks. 
After you have entered the required data on the Composite Energy Use Ratio 
Screen, select the Calculate button. MHEA will initiate the energy use ratio 
calculation. When the calculation is completed, the base 65 heating and 
cooling degree-days for the weather site you selected and the energy use ratio 
will appear near the bottom of the Composite Energy Use Ratio screen. 
Select the Continue button located at the bottom of the Composite Energy 
Use Ratio screen to leave this screen and return to the About screen. 
Select the Continue button located at the bottom of the About screen to leave 
this screen and continue working with the MHEA software. 

. 
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Note 

Note 

Note 

A Composite Energy Use Ratio is an estimated value and should be 
used to identify homes with sufficient energy use to justify 
weatherization or as an indicator of unusual energy use conditions 
which may require special attention. 

Each weatherization agency must determine what an appropriate 
energy use/square footheating degree-day ratio is to justify 
weatherization of the manufactured home. 

- 

Ratios calculated using the Estimate Energy User Ratio screen are not 
stored by h4HEA and cannot be accessed for future reference. 

Figure 1-6 The "Estimate Energy User Ratio" Screen 

1.4.3 Quitting MHEA 

To leave MHEA and return to MS-DOS@, you may use any of the commands 
listed below. 
Method A 

With your mouse, highlight the menu option Quit located at the top center of 
the screen and press the left mouse key. 
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If you made changes to the audit since you last saved the file, MHEA will ask 
if you would like to save those changes before quitting. Choose the Okay 
button to save the file and exit the program, or press the Cancel button to exit 
without saving. Choose the Okay or Cancel button by highlighting the 
button with your mouse and then pressing the left mouse button. 

Method B 
Simultaneously hold the ALT and Q keys on your computer. 

If you made changes to the audit since you last saved the file, MHEA will ask 
if you would like to save those changes before quitting. Choose the Okay 
button by pressing ALT and 0 to save the file and exit the p r o a m ,  or press 
the Cancel button, by pressing ALT and C, to exit without saving. 

Method C 
With the left and right ARROW keys on your keyboard, highlight the menu 
option Quit located at the top center of your screen and press the ENTER key 
on your keyboard. i 

If you made changes to the audit since you last saved the file, MHEA will ask 
if you would like to save those changes before quitting. Using the ARROW 
keys on your keyboard, highhght the Okay button to save the file and exit the 
program, or the Cancel button to exit without saving then press the ENTER 
key on your keyboard. 

Method D 
Simultaneously hold the SHIFT key and one of the ARROW keys on your 
keyboard until you have highlighted the word Quit located in the top center of 
your screen then press the ENTER key on your keyboard. 

If you made changes to the audit since you last saved the file, MHEA will ask 
if you would like to save those changes before quitting. Choose the Okay 
button to save the file and exit the program, or press the Cancel button to exit 
without saving. Do this by simultaneously holding the SHIFT and ARROW keys 
on your keyboard until the Okay or Cancel button in the question box is 
highlighted, then press the ENTER key on your keyboard. 

Note The MHEA screen must be blank before you can quit the software, 
except for the border and the menu items listed along the top of the 
screen. 

Refer to section 1.3, Navigating Through MHEA, for more information on how 
to move the cursor to highlight and pick items in MHEA. 
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1.4.4 

1.5 

Saving MHEA Project Files 
You need to save your work. Computer memory is temporarily allocated when 
you create a new audit (see Section 3.1.17 New) in a subdirectory called 
“projects.” To save an audit in your computer’s permanent memory, select the 
Save/Copy submenu within the File menu and complete the submenu screen. As 
you update the audit, you will need to save the file for future use (see Section 
3.1.3, Save/Copy Audit). 

Understanding MHEA Screens 
Understanding features incorporated into the screens and message boxes you see 
while working through MHEA will help you enter data and evaluate results more 
efficiently. A menu bar and a status bar appear on all screens. All screens and 
message boxes have buttons. Most have editable fields and check boxes, and 
some have scroll bars. You will learn about these features in this section (see 
Figure 1-7). 

Editable Field- Check Box LButton 

Figure 1-7A Typical MHEA Screen with Buttons, Editable Fields, and Check 
Boxes 

I 
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DEMO : MHEA Audit Sample 
TEST1 : Doe, J a n e  
TEST2 : Doe, John I TEST3 : Doe, J a n e  

Figure 1-7B Typical MHEA Screen with Scroll Bar 

1.5.1 Menu Bar 
The menu bar is located at the top of MHEA background screen (see Figure 1-8). 
It contains the following headings: The File, Inpvts, Run, View, Quit, Setup, 
and Help. Each menu has a pull-down submenu list. You can view d e  submenus 
by selecting a menu heading using any of the methods described in Section 1.3, 
Navigating Through MHEA. 
The menu bar is always visible while you are using MHEA. In order to select any 
of the menu items, you must first clear displayed screens or message boxes. To 
clear a screen or box, press the Okay or Cancel buttons. 
MHEA version number is displayed at the far right of the menu bar. 

Note Menu heqdings are often referred to as “main menu items“ throughout 
this manual. 
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MHEA Version 

Main Menu Items 

-Submenus 

MHEA Version 
Number 

Menu Items 

Figure 1-8 Typical MHEA Screen Showing Main Menu, Submenu, and Version 
Number 

1.5.2 Buttons 
Buttons are the gray boxes that contain a word or phase. They look slightly taller 
than the screen. When you select the button, it appears as though you have 
pressed it into the screen. 
Every screen or message box has an Okay button located either in the lower right 
comer or the lower center of the screen or message box (see Figue 1-9). Most 
screens and message boxes also have Cancel buttons at similar locations, and all 
the Inputs and Setup screens will have a Default button. Several other buttons 
you will see include Reset Defaults, Add, Delete, Next, Previous, and buttons 
specific to an individual screen. 
Select the Okay button to accept the screen being displayed and continue working 
on other parts of MHEA. For example, after you have made changes to an input 
or a setup screen, select the Okay button to save the changes. When a warning 
message appears on the screen, select the Okay button after reading the message 
to accept the condition described in the message and return to MHEA. If you do 
not want to store information you revised while most recently viewing an input or 
setup screen or if you do not want to accept a condition described in a warning 
message, select the Cancel button. Finally, the Default button will change the 
inputs shown on the screen to those stored as MHEA default data. Refer to 
sections 1.6, Interpreting MHEA Warning Messages, and 1.3, Navigating 
Through MHEA, to learn more about warning messages and selecting buttons. 
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V 
Buttons 

Fieme 1-9 Typical MHEA Screen Showing Buttons 
Help messages describing the function of each button are accessed by 
highlighting the button and pressing the right mouse key or the F1 key on your 
keyboard. Learn more about help messages by reading Chapter 2.0, Using On- 
Line Help. 

1 S.3 Check Marks 
You will find many screens have lists of options with a column containing square 
boxes for each option to the left of the list (see Figure 1-10). Select an option by 
placing a check mark in the square box next to the appropriate option. Place a 
check by highlighting one of the square boxes and pressing ENTER or using any of 
the keyboard selection methods described in Section 1.3, Navigating Through 
MHEA. 
You may choose only one option in most option lists. You do not need to remove 
existing check marks before placing a new check mark. If you decide to select a 
different option than one that is checked, highlight and select thc box next to the 
new option using any of the methods described in Section 1.3, Navigating 
Through MHEA. 
There are two methods for handling the situation when you have accidentally 
placed a check mark in a list where you do not want to select any of the options 
and you cannot remove the check. The first is to ignore the mistake. The 
software compares data inputs to be sure that all data combinations make sense. 
If you accidentally place a check mark where it should not be, a message will 
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come onto the screen telling you about the mismatch and that the unintended 
checked option will be ignored during the calculations. The second method is to 
select the Defaults button in the lower right comer of the input screen. MHEA 
will erase everything you have entered on the screen and the screen returns to its 
original form. You may then reenter all information for the screen. 

check 
Boxes 

Figure 1-10 Typical MHEA Screen Showing Check Boxes 
Several screens such as the Candidate Measures setup screen and Files to Print 
screen let you place multiple check marks and uncheck selected options. Place 
check marks as you do for all other screens using either the mouse or keyboard. 
Remove check marks on these screens by reselecting the item for which you want 
to remove the check mark. 

1.5.4 Editable Fields 
Editable fields are those locations in MHEA where you enter characters from the 
keyboard (see Figure 1-11). Usually these characters are numbers. Some fields 
may require letters or any other keyboard character. To enter a character, select 
the field using mouse or keyboard methods described in Section 1.3, Navigating 
Through MHEA. After you have entered the appropriate characters, the software 
will remember what you have typed when you move on to a new screen entry 
location. 
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Editable Fields 

Figure 1-1 1 Typical MHEA Screen Showing Editable Fields 
You may use edit controls from your keyboard to enter and revise infomation in 
the editable field. For example, you may use the delete key or backspace key to 
remove characters you wish to change. You may make changes before leaving 
the field for the first time, or you may return to the screen at a later time to correct 
characters that were previously entered. 

Note You cannot use the ALTbtter key method for accessing editable 
fields. Refer to Section 1.3, Navigating Through MHEA, for more 
information on other methods for moving the cursor using the mouse 
and keyboard controls. 

1.5.5 Scroll Bars 
Scroll bars appear on screens when they contain more information than can fit 
onto the one screen (see F ig re  1-12). The scroll bar is located vertically along 
the right side of the screen. The easiest method for sliding the scroll bar up and 
down is to use the mouse. With the mouse, point the cursor to the light gray 
portion of the scroll bar. When you have pointed the cursor to a correct location, 
the light gray portion will become dark gray. While holding down the left mouse 
key, pull the now dark gray portion down (or push up). When you release the left 
mouse key, the screen will adjust to the new position. 

. 
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1 S.6 

Scroll 
Bar 

- 

Figure 1-12 Typical MHEA Screen Showing a Scroll Bar 
You may also use the mouse to click onto either of the two down arrows at the 
bottom of the scroll bar or to the up arrows at the top of the scroll bar. Click onto 
the arrow with a line along the base to move to the beginning (up arrow) or the 
end (down arrow) of the screen. Click once on the arrow without the line along 
the base to move the screen up one line (up arrow) or down one line (down 
arrow). If you point the cursor to an arrow without a line along the base and hold 
the left mouse key, the screen will scroll up or down line-by-line until you release 
the left mouse key. 
You can move through these extended screens by using the up and down mows 
on your keyboard: Press and hold the up or down ARROW key on your keyboard 
until the screen has moved up or down the number of lines you wish it to move. 
You may also move the text up or down one screen at a time by pressing the page 
up or page down keys on your keyboard. 

Status Bar 
The status bar is located at the bottom of the MHEA background screen (see 
Figure 1-13). The status bar indicates how to access help messages and shows the 
name of the audit Ne you are presently working in. The status bar is always 
visible while you are using MHEA. 
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I .6 

-Status Bar 
Figure 1-13 Typical MHEA Screen Showing the Status Bar 

Interpreting MHEA Warning Messages 
MHEA may display warning messages (see Figure 1-14). These messages are not 
fatal. They simply request an action that you must complete before the software 
can continue operating. 
These warning messages inform you of two things: 1) that you have entered a 
value that is either outside a typical range or is unacceptably large or small; and 
2) that you have neglected to perform a function needed for proper operation of 
MHEA. Informing you that the value you entered is beyond a recommended or 
acceptable range is known as range checking. If the value is outside a typical 
range, ME3EA will display a message asking if you would like to change the 
value. If you choose to leave the value as it was entered, select the Okay button 
on the message screen, otherwise select the Cancel button to change the value. 
On the other hand, if you have entered a value that is beyond an acceptable range, 
a message will appear instructing you to change the value. MHEA will not 
continue until you have entered an acceptable value. 
The second type of waming messages, those that indicate you neglected to 
perform a function needed for proper operation of MHEA, explain what you need 
to do to continue using MHEA. For example, the messages may appear if you 
have not created or opened a project fde before you tried to enter data or if you 
attempt to view results before you have run the calculations. 
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Warning 

I ?ile(sf not Found. 
use the File menu to select a project file 
or Run menl: to craate missing resules. 

b .~, 

Figure 1-14 Typical MHEA Warning Message 

1.7 Printing from MHEA 
MHEA can send information to most printer types. It automatically identifies the 
printer that is connected to the computer you are using when you send a file (or 
files) to the printer. To print files, select the Print submenu item from the File 
submenu list. A screen titled Check Files to Print will appear (see Figure 1-15). 
Using your mouse, highlight the file name you wish to print and click the left 
mouse button to select the Ne. A check will appear in the column to the left of 
the file titles for the files you have selected to be printed. You may also select 
files using your up/down mow keys to highlight a file name and pressing the 
ENTER key to place the check mark. You may select multiple files. To deselect a 
file, highlight the file name (with the mouse or the arrow keys) and click the left 
mouse button or press the ENTER key to remove the check mark. Finally, select 
the Okay button to activate the printer. 
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2.0 Using On-Line 
Help 

Help messages are available throughout MHEA. These messages provide definitions of data 
input requirements, hints for locating input information, retrofit measure descriptions, 
suggested methods for installing retrofits, and other useful information. This chapter will 
cover how to access the help messages and to use the available help to the best of your 
advantage. 

2.1 

2.2 

2.2.1 

2.2.2 

Where to Find Help 
Help messages exist for every menu item, button, check box, and editable field in 
MHEA. You can read help messages at any time while you are working with the 
software. When you exit the help message screen, MHEA will return your cursor to 
the point where you called the message. 

How to Access Help 
This section discusses two methods for viewing help messages. Start MHEA on your 
computer and follow one of the two methods outlined in this section to practice 
accessing several help messages. 

Accessing Help from MHEA User  Screens 

Display any MHEA screen to practice the procedure summarized in this section. It is 
recommended that you display an input screen because of the many help messages 
available for these screens. 
1. Highlight the menu item, button, check box, or editible field for which you would 

like to read the corresponding help message. Move the cursor to the item in 
question by using the techniques describedin Section 1.3, Navigating Through 
MHEA. 

2. Press the right mouse key or the F1 key on the keyboard to display the help 
.message. 

NOTE If you attempt to access help without having an item highlighted, a general 
message titled “Help on Using MHEA” will appear. 

Accessing Help from MHEA Help Menu 

Follow the steps outlined in this section to access Help messages fiom within the 
Help menu item (see Figure 2-1). 
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1. 

2. 

3. 

4. 

MHEA Help menu contains several submenus. To display the submenus, select 
the word Help on the main menu bar (located at the far right of the main menu 
bar) using any of the cursor movement options described in Section 1.3, 
Navigating Through MHEA. 
A list of Help options will appear. These are Help submenu items. To view help 
messages, select the first submenu, whose title is Help Topics. 
A list of help message titles will appear. Scroll through this list until you have 
reached the message you wish to read (see Section 1.5.5, Scroll Bars). 
Select the message you wish to read either by highlighting the message title with 
your mouse and pressing the left mouse key or by highlighting the title with the 
ARROW keys and pressing the ENTER key on your keyboard. 

Figure 2-1 Help Submenu Options 

2.3 Understanding the Help Screen 
All the help screens will all have the same screen format (see Figure 2-2). MHEA 
displays the message inside a dialog box. The title of the help message is displayed 
in the border at the top of the box. Inside the bottom border are buttons with the 
words index, Back Up, Okay, eePrev, and Next>>. Within the border along the 
right side of the box are Up and Down arrow buttons. 
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trying t o  point at with t h e  a r row cursor, o r  if you a r e  on an 
object tha t  does not have specific help material attached, you will 
get  th i s  message when you t r y  t o  access  the  help. Normally, if 
you press  F1 or the right mouse button when you a r e  pointing a t  
an object (menu items included), you will see help material  

I 
specific t o  tha t  object. 

The bottom of the help box has buttons fo r  backing-up, viewing a list of 
topics in an index, and moving f rom one help topic t o  the next. On the 
lower r igh t  hand side of the help fo rm a r e  buttons f o r  paging through long 

<more text> 

Hypertext is the  highlighted t ex t  you see in a different color. If you move 
the  cursor  t o  t he  highlighted word(s1 and press  the  left mouse key, you 
will see more information on tha t  topic o r  word. Note tha t  the  t i t l e  of 
the  help material  is shown a t  t he  top of the  help box tha t  pops up on the  
screen. 

Figure 2-2 Typical MHEA Help Screen 
index 

If you select the Index button, an alphabetical listing of help message titles will 
be displayed. Select a title either using your mouse or the keyboard (see Section 
1.3, Navigating Through =A). You may use the scroll bar to view portions of 
the title list that will not fit into the screen (see Section 1.5.5, Scroll Bars). After 
you have selected a message title, you may view the message by selecting the 
Okay button on the Index screen. If you choose not to view a help message, 
select the Cancel button on the Index screen. MHEA will then return to the help 
message you were viewing when you selected the Index button. 

Back-up 
Select the Back-up button to view the help message that is stored immediately 
before the message that is currently on the screen. Each help message has an 
assigned storage location in MHEA. You may back through the messages as 
many times as you wish until you have reached the first message stored by 
MHEA. The message titled “Help on Using MHEA” (the message that is 
accessed by pressing the right mouse key or the F1 key when you have not 
highlighted an item for which to access help) is the first help message MHEA 
stores. Because there are no messages before this one, you will not be able to 
activate the Back-up button when this first message is displayed. 

Okay 
When you have finished reading a message select the Okay button. You will 
return to the screen from which you called the help message. 

Using On-Line Help 27 



ccPrev 
This abbreviation means previous. Select the ccPrev button to view the help 
message stored immediately before the message currently on the screen. Each 
help message has an assigned storage location in MHEA. You may back through 
the messages as many times as you wish until you have reached the frrst message 
in MHEA help message storage. 

Next>> 
Select the Next>> button to view the help message stored immediately after the 
message that is currently on the screen. Each help message has an assigned 
storage location in MHEA. Move forward through the messages until you have 
reached the last message in MHEA help message storage. 

UdDown 
If the help message is longer than can be shown on one screen, you may view the 
remaining portion of the message by selecting the Up and Down buttons. When 
selected, these buttons will move the message screen up or down by one page, 
where the portion of the message that you see on the screen is the same as one 
page. If the message will fit onto one screen, you will not be able to activate the 
Up and Down buttons. 

Some help messages include a simple graphic to give further information than what is 
included in the text. These graphics will appear when the help message is displayed. 

NOTE Select buttons either by highlighting them with your mouse and pressing 
the left mouse key or by using any of the keyboard cursor movements 
described in Section 1.3, Navigating Through MHEA. 

2.4 How to Exit Help 
All help message screens will have an Okay button at the bottom center of the screen 
(see Figure 2-3). Select this button to close the help message and return to the screen 
that you were viewing when you accessed help. 
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2.5.2 About 

The "About" screen displays a brief description of MHEA software (see Figure 2-4). 

 MANUFACTURE^ Honk ENERW hdi~ 
Version 209 

prepared for the 

US DEpARTMarr of EMRw 
W E 4 d T i O N  ASSiSTANCE PRoCjw 

prepared by the 

NATioNAL RsVEwAblE ENERqy LAboRAToRy 

August 29. 1997 

Figure 2-4 The "About" Screen 
You may access the About screen by selecting the About submenu option found 
within the Help main menu item. A description about the Instructions and Estimate 
features is given in Section 1.4.2, "The About Screen." 
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3.0 Performing an Audit 
From this chapter, you will learn how to evaluate retrofit measures for a manufactured home 
using MHEA. You will become familiar with using the main menu items, submenu items, 
and input data screens, and viewing the results. 

Open Project File 
Create New Audit 
Open Existing Audit 

Input Data 
General 
Construction 
Equipment 
Additions 

Adjust Setup 
Parameters 

Run Calculations 

View Results 

I QuitMHEA I 

Figure 3-1 MHEA Flow Chart 

3.1 Managing Project Files Using the File Menu 
Use the submenu options available from within the File menu to create, open, copy, 
delete, and print project files (see Figure 3-2). This section describes how to use each 
of the File submenu items in order to manage your project files. 
The MHEA File menu contains several submenus. To display the submenus, select 
the word File on the main menu bar (located at the far left of the top menu bar) using 
any of the cursor movement options described in Section 1.3, Navigating Through 
MHEA. 

NOTE When you create a new project file, MHEA assigns space in the computer 
memory to store the data you enter (projects directory), the calculated 
results (results directory), and adjusted setup data. You will need to save 
the project file using the SaveKopy feature (Section 3.1.3). 



NOTE You may create, open, save, close, copy, delete, or print project files at 
any time while you are working within MHEA. If you are entering data 
about one manufactured home and you decide to switch to another, simply 
return to the File menu and choose one of the submenu items. All 
information you entered in the project file you leave will need to be stored. 

Figure 3-2 File Submenu Options 

3.1.1 New 

When you are ready to describe a manufactured home for the first time, you must 
identify a location in the computer memory to store information about this home. 
Follow the steps outlined in this section to create a new audit. 
1. From the File submenu list, select New. Use any of the methods described in 

Section 1.3, Navigating Through MHEA, to select the submenu item. 
2. A screen with the title “New Audit File” will appear (see Figure 3-3). Your 

cursor should automatically be in the editable field next to the title “Client 
Name.” Enter the name of the client who lives in the manufactured home you are 
evaluating. The client name is not required. However, it is recommended that 
you enter a name so that you are able to more quickly recognize which home data 
is stored within the eight-character project file identifier (see step 4). The name 
you enter will automatically appear in the Client Name editable field on the 
“General Information” screen (accessed from within the Inputs menu). 
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Figure 3-3 The “New Audit File,’ Screen 
3. Move your cursor to the other editable field shown on this screen using any of the 

methods described in Section 1.3, Navigating Though MHEA. 
4. Enter a project file identifier that is eight or less characters long in the “File 

Name” field. The project file identifier will mark the computer memory storage 
location for all the project files. 

5. When you are satisfied with the Client Name and the File Name, accept the 
information by selecting the Okay button located at the bottom left of the New 
Audit File screen. If you decide you do not waht to create a new audit, select the 
Cancel button (located bottom right of the New Audit File screen). All 
information you have entered onto the New Audit File screen will be ignored if 
you select the Cancel button. After having selected the Okay or Cancel button, 
MHEA will return to a screen showing only the FiIe submenu items. 

, NOTE You may edit both the House Description and the File Name before you 
select the Okay button. If you wish to change an audit file name, refer to 
Section 3.1.3, SaveKopy. You may change the client name from within 
the “General Information” screen (accessed from within the Inputs menu). 

NOTE When you create a new project file, MHEA assigns space in the computer 
memory to store the data you enter (projects directory), the calculated 
results (results directory), and adjusted setup data. You will need to save 
the project file using the SaveKopy feature (Section 3.1.3). 



3.1.2 Open 
After you have created a project file, you may return at a later time to make changes, 
review or rerun the calculations, or print file information. The three steps below 
summarize how to open an existing project file using the Open submenu item. 
1. From the File submenu option list, select Open. Use any of the methods 

described in Section 1.3, Navigating Through MHEA, to select the submenu item. 
2. A screen with the title "Select Audit File" will appear (see Figure 3-4). This 

screen contains a list of existing project files. Scroll through the project files until 
you have highlighted the one you wish to open. Select this project file by 
pressing ENTER so that it also appears in the narrow box near the top of the Select 
Audit File screen. Refer to Section 1.5.5, Scroll Bars, for more information on 
how to scroll through the project Ne list. 

TEST1 : Doe, Jane 
TEST2 : Doe, John 
TEST3 : Doe, Jane 

Fipre  3-4 The "Select Audit File" Screen 
3. Select the Okay button (located at the bottom center of the "Select Audit File" 

screen) to open the project file. If you decide you do not wish to open a project 
file, select the Cancel button (located at the bottom center of the "Select Audit 
File" screen). After having selected the Okay or Cancel buttons, MHEA will 
return to a screen showing only the File submenu items. 

NOTE When you open and make changes to an existing project file, all the new 
information is not stored as you enter the data. You will need to store the 
file using the Save/Copy feature (Section 3.1.3). 
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3.1.3 SaveICopy 

The Save/Copy submenu option permits you to save a project file or copy one with a 
new name. You will need to use this feature to save any changes that you may have 
made to your audit. 
You may find the Save with New Name option especially useful if you have two 
manufactured homes that are nearly identical. After having entered data about the 
first home, copy the project file to a new name, open the new file using the Open 
submenu, and make the necessary changes to reflect the characteristics of the second 
home. 
Follow the five-step procedure below to save or copy a project file. 
1. 

2. 

3. 

4. 

5. 

Open a project file using the Open submenu option described in Section 3.1.2. 
MHEA saves the project file you have open when you select the Save/Copy 
submenu. 
From the File submenu option list, select Save/Copy. Use any of the methods 
described in Section 1.3, Navigating Through MHEA, to select the submenu item. 
A screen with the title “Save or Save with New Name” will appear (see Fiewe 3- 
5). Your cursor should automatically be in the editable field next to the title “File 
Name.” Enter a project fde identifier that is eight or less characters long. The 
“Directory” portion of the screen will display the directory to which you are 
saving the file (“projects\” is the default directory). 
If you wish to overwrite an existing file with the same file name, place a check 
mark in the Yes box in the “Overwrite OK?” portion of the screen. If you do not 
wish to overwrite the existing file, check the No box. If you checked No, then 
enter a new file name in the “File Name’’ field. 
Select the Okay button (located at the bottom center of the “Save/Copy” screen) 
to save the project file. If you decide you do not wish to save the project file, 
select the Cancel button. After having selected the Okay or Cancel button, 
MHEA will return to a screen showing only the File submenu items. 

WARNING Remember to open the copied project fde name before you be,* to 
make changes (see Section 3.1.2, Open). If you do not open the new 
project file, you may accidentally make changes to the original 
project file. The project file name that you have opened is displayed 
at the bottom of your computer screen in the status bar (see Section 
1.5.6, Status Bar). Check that you are working in the correct project 
file before you be,* to make revisions. 

NOTE You may change the client name by revising the name on the “General 
Information” screen (found within the Inputs menu). The new name will 
be saved with the copied project fde name when you save the revised 
audit. 
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Fiawe 3-5 The “Save or Save with New Name” Screen 

3.1.4 Close 
If you wish to close the audit that is currently open, select the Close submenu option 
in the File menu. If you have not saved your audit since you last made changes, 
MHEA will suggest that you do so. Choose Okay to close the audit without saving 
it, or select the Cancel button to ignore. 

3.1.5 Delete 
If you decide you no longer want to store information about a particular manufactured 
home, you can remove the information from your computer’s memory by using the 
Delete submenu option. Delete project files by following the four steps below. 
1. From the File submenu option list, select Delete. Use any of the methods 

described in Section 1.3, Navigating Through MHEA, to select the submenu item. 
2. The “Check Files to Erase” screen will appear (see Figure 3-6). This screen 

contains a list of existing project files. Scroll through the project files until you 
have highlighted the files you wish to delete. Select these project files so that a 
check mark appears next to the files that you wish to delete. 

, 
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rESTl : Doe, Jane 
TEST2 : Doe, Jane 

Figure 3-6 The "Delete" Screen 
3. Select the Okay button to delete the project files. If you decide you do not want 

to delete the project files, select the Cancel button. After having selected the 
Okay or Cancel button, MHEA will return to a screen showing only the File 
submenu items. 

WARNING Be sure you no longer need the audit information before you decide 
to delete the project file. When you delete an audit, you have 
permanently removed the project file from the computer memory. 

3.1.6 Printer Setup 

MHEA automatically identifies the printer to which your computer is attached. You 
do not need to identify a new printer if you change printers. 

3.1.7 Print 

You may print results, comments, and input summaries from the Print submenu. 
When you select this submenu, a list of the items you may print appears. Scroll 
through this list, place a check mark next to the screens you want to print (see Section 
1.5.5, Scroll Bars, and Section 1.3, Navigating Through MHEA), and select the Okay 
button to print. 
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3.1.8 DOS Shell 

In order to go to a DOS screen while in MHEA, select the DOS Shell option in the 
File menu. This option will allow you to be in a DOS shell while st i l l  running the 
MHEA software. When you wish to return to the program, type exit. 

NOTE Be sure that you are in the "c:\mhea\" directory when you type exit to 
return to the program. 

3.2 Enter Input Data Using the Inputs Menu 
All data describing the manufactured home construction, heating equipment, and 
cooling equipment are entered on the description screens contained in the Inputs 
menu (see Figure 3-7). You may access the description screens by opening the 
Inputs menu (second menu heading from the left on the top menu bar) to display all 
submenu items. Select submenu items to view the description input screens. 
Submenu items are described individually in this section of the manual in the order 
that they appear. 

Figure 3-7 Inputs Submenu Options 

3.2.1 General Information 

Enter miscellaneous home data on the "General Information" screen (see Figure 3-8). 
The screen displays record-keeping information about the individual manufactured 
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home as well as information related to several of the construction description screens 
described in Section 3.2.2, Construction. Record-keeping information is not required 
to successfully run MHEA. Required inputs on the "General Information" screen are 
the home dimensions, water heater closet location, wind shielding, and either the 
home leakiness or the blower door test results. 

Figure 3-8 The "General Information" Screen 
Client Name 

The client name will automatically be forwarded from the "New Audit File" 
screen (found within the File submenu). If you did not enter a client name on the 
New Audit File screen or if you wish to change the client name, you may do so by 
entering a new name in the client name editable field on the General Information 
screen. The new name will appear next to the eight-character audit file name that 
is listed when you select the Open or Delete screens found within the File 
submenu. The client name will also appear on the results screens. 

Client Address 
Enter the address of the manufactured home. The client address entry is optional. 
It is not needed for the calculations but is available to help with your record 
keeping. The client address will appear on the results screens. 

Citv, State 
Enter the city and state where the manufactured home is located. The city and 
state entry is optional. It is not needed for the calculations but is available to help 
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with your record keeping. The city and state entry will appear on the results 
screens. 

ZR Code 
Enter the postal zip code where the manufactured home you are evaluating is 
located. The zip code entry is optional. It is not needed for the calculations but is 
available to help with your record keeping. The zip code will appear on the results 
screens. 

Audit Date 
The date you create the audit file will automatically appear in the Audit Date 
editable field. You may change this date by selecting this editable field with your 
mouse or keyboard cursor movements and typing in the new date. The audit date 
entry is optional. It is not needed for the calculations but is available to help with 
your record keeping. The audit date will appear on the results screens. 

Auditor 
Enter an identification of the person who performed the evaluation of the 
manufactured home. The auditor entry is optional. It is not needed for the 
calculations but is available to help with your record keeping. The auditor will 
appear on the results screens. 

Enter the job identification number assigned to the audit according to your record- 
keeping system. The job number entry is optional. It is not needed for the 
calculations but is available to help with your record keeping. The job number 
will appear on the results screens. 

Job No. 

Len& Cft) 
Enter the length of the home in feet (see Figure 3-9). Manufactured home lengths 
are typically in the range of 40 feet to 80 feet. The home length is the length of 
the living space. Do not include the length of the towing tongue that extends out 
from one end of the manufactured home. 

Width#Cft) 
Enter the width of the home in feet (see Figure 3-9). Manufactured home widths 
are typically in the range of 12 feet to 30 feet. 

Interior Wall Height Cft) 
Enter in feet the height of the home as measured from the floor to the ceiling in 
the interior of the home (see Figure 3-9). Measurements should be taken along an 
exterior wall of the home. The interior height of manufactured homes is typically 
7 feet. 
Occasionally, a manufactured home will have a change in ceiling height or floor 
level. If there is a cathedral ceiling, enter the interior wall height at the low 
section of the cathedral ceiling as though the ceiling was flat. MHEA will 
calculate the additional wall area resulting from the cathedral ceiling based on 
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information provided on the "RooflCeiling" screen (see Section 3.2.2.5). If there 
is a step in the floor level and there is not a corresponding step in the flat-ceiling 
height, enter the average interior wall height for the home. Also, enter the 
average interior wall height if the flat ceiling has a step height change but not a 
corresponding change in the floor level. 

bowing tongue / 
cDAH07d[1342506 

Figure 3-9 Manufactured home Dimensions 
Outdoor Water Heater Closet 

Indicate whether or not the water heater is housed in an unconditioned closet with 
an exterior access. If an outdoor closet exists, the calculations will not include it 
in the conditioned portion of the home. The wall, floor, and ceiling areas of the 
home are adjusted to account for a "30 X 30" inch water heater closet. 

Wind Shielding 
Place a check next to the option that best describes how well the manufactured 
home is shielded. A correction factor is included in the infiltration calculation for 
the relative amount of external wind shielding. A well-shielded home may be 
surrounded by thick vegetation, in a small valley that seldom experiences windy 
conditions, or closely surrounded by other homes and buildings. A normally 
shielded home may be one that is found in a typical manufactured home housing 
park where there are surrounding homes and some surrounding vegetation. An 
exposed home has no surrounding vegetation or buildings to protect it fiom the 
wind. 

Health & Safety ($1 
Enter health and safety expenses that must be included with the overall 
weatherization retrofit cost. If the additional costs are to be applied to individual 
retrofit measures, adjust the material, labor, and other costs for the retrofit 
measures under the Measure Costs option witbin the Setup main menu item (see 
Sction 4.1, Update Measure Costs). 

~ ~~ 
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NOTE It is the responsibility of the weatherization agency conducting the audit to 
determine what the health and safety issues are. MHEA is a tool to help 
determine cost-effective weatherization retrofit measures. It cannot 
indicate health and safety concerns. 

Remir ($1 
Enter repair costs that must be included with the overall weatherization retrofit 
cost. If the additional costs are to be applied to individual retrofit measures, 
adjust the material, labor, and other costs for the retrofit measures under the 
Measure Costs option within the Setup main menu item (see Section 4.1 , Update 
Measure Costs). 

Miscellaneous 6) 
Enter the various expenses that cannot be classified as health and safety or repair 
expenses. If the additional costs are to be applied to individual retrofit measures, 
adjust the material, labor, and other costs for the retrofit measures under the 
Measure Costs option within the Setup main menu item (see Section 4.1 , Update 
Measure Costs). . 

Include Other Costs in SIR 
Place a check next to the Include Other Costs in the savings-to-investment ratio 
(SIR) check box if you want all “Other Costs” to be included in the retrofit 
savings-to-investment ratio calculations. If the box is not checked, “Other Costs” 
will appear in the cost results summary but not be applied to the cumulative cost 
of the retrofit package. 

NOTE If “Other Costs” are significant and included in the SIR calculations, they 
may have the effect of eliminating some measures from consideration due 
to a high fxed cost to implement a package of measures. 

Home Leakiness 
If you are unable to conduct a blower door test of the home, you can check an 
approximation of the home leakiness. A tight home will show no evidence of air 
movement around windows, doors, wall sockets, and other wall, ceiling, and floor 
penetrations. A medium-tight home will show some evidence of air movement 
around these penetrations. Finally, a loose home will have dust around windows 
and floor, wall, and ceiling penetrations. MHEA assumption for tight-, medium-, 
and loose-home infiltration rates may be adjusted using the Defaults submenu 
within the main menu item Setup (see Section 4.5.2, Default Parameters). 

NOTE It is highly recommended that a blower door test be conducted on all 
homes. Visual approximations of home leakage could result in inaccurate 
program calculations. Blower door tests will also ensure that the home 
infiltration rate is not below the minimum rate recommended for occupant 
safety. 
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Pre-Duct Sealing (cfm) 
Enter the single-point blower door test value at 50 Pa of pressure measured before 
duct sealing or other infiltration reduction efforts have been completed. This 
value will be used to calculate the effect of infiltration on the energy usage of the 
manufactured home. The pre-duct-sealing input is required only if you have not 
checked a home leakiness option. 

Post-Duct Sealing (cfm) 
Enter the single-point blower door test value at 50 Pa of pressure measured after 
completing duct sealing or other infiltration reduction efforts. This value will be 
used to calculate the effect of infiltration on the energy usage of the manufactured 
home. The post-duct-sealing input is not required. However, MHEA will more 
accurately estimate the energy savings associated with the duct-sealing retrofit if a 
blower door test value is entered. 

3.2.2 Construction 

Enter construction characteristics of the manufactured home on the description 
screens available within the Construction submenu. Each screen represents a 
different section of the manufactured home. 

NOTE You may open the manufactured home construction description screens in 
any order to enter information about the home. You do not necessarily 
need to start with the screen that is listed first and move down 
sequentially. It is recommended that you complete the screens in a logical 
order so that you do not overlook any screens. The software calculations 
will run only if alI construction description screens are completed. If you 
have neglected to complete a required construction description screen 
before you try to run MHEA calculations, a warning message will appear 
asking you to enter the missing information before continuing with the 
calculations. 

3.2.2.1 FIoor 

The "Floor" input screen contains information about the manufactured home 
floorbelly section (see Figure 3-10). The screen is divided into four sections. These 
sections are general floor information, floor wing description, floor belly (center) 
description, and general belly information (see Figure 3-1 1). 

Floor Joist Direction 
The floor joist is the wood framing that supports the interior floor. Enter the 
direction the floor joists are installed. Lengthwise floor joists are installed 
parallel to the long dimension (length) of the home (see Figure 3-12). Widthwise 
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floor joists are installed parallel to the short dimension (width) of the home. The 
floor joist direction is needed to calculate more accurately the volume of the 
belly section, and indicates where a central air supply duct is located (between 
joists or below joists), and to calculate more accurately the insulating value (R- 
value) of the floor. 

- - 
- - 

Figure 3-10 The “Floor” Screen 

cD-RHoI-Ao342M7 

Figure 3-1 1 Section of a Typical Manufactured home Floor 
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Lengthwise floor joists 

Widthwise floor joists 

Figure 3-12 Lengthwise and Widthwise Floor Joists 
Batt/Blanket Direction 

Indicate if batt/blanket insulation exists and if it does exist, the direction in which 
it is installed. Banlblanket insulation that has been installed lengthwise is parallel 
to the long dimension (length) of the home. Insulation that has been installed 
widthwise is parallel to the short dimension (width) of the home. The insulation 
direction is needed to calculate more accurately the R-value of existing 
batt/blanket insulation that is attached to the flooring or floor joist. Place a check 
next to the option indicating the insulation location as the Batt/Blanket Insulation 
Location input on I' Floor" input screen. 
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NOTE You may view and, if necessary, adjust the R-value MHEA assigns to all 
insulation types from within the Defaults submenu located under the 
Setup main menu. Refer to Section 4.5.2, Default Parameters, for more 
information. 

Indicate whether or not a skirt exists around the exterior of the home. Research 
has shown that skirting only protects the manufactured home belly from exposure 
to the wind. If skirting exists, MHEA adjusts the exterior R-value to account for 
the absence of wind when the total R-value of the floorbelly section is calculated. 

Floor Joist Size 
The floor joist is the wood framing that supports the interior floor. Manufactured 
homes are typically constructed using standard wood framing. Sometimes, the 
floor joist size is different in the wing section than in the belly (center) section. 
Indicate the dimensions of the floor joists in both the wing and belly sections. 
ME-IEA needs this information to calculate the floor R-value and the volume of 
the floorbelly section. 

NOTE The nominal dimensions (those dimensions you measure with your tape 
measure) are less than the standard dimensions listed. For example, a 2" x 
4" board will actually have the dimensions of 1-3/4" x 3-1/2". The 
options listed in MHEA are the standard dimensions used by the U.S. 
lumber industry. 

Insulation Tyuemaickness 
Enter the amount of existing batt/blanket and loose-fill insulation. By entering a 
value greater than 0 inches, you are implying that the insulation exists. If you 
enter a thickness of 0 inches, MHEA assumes that insulation of that type does not 
exist. Occasionally, the insulation existing in the wing section is different than 
that located in the belly section. Enter the amount of existing insulation for both 
sections. 
Batt/blanket insulation is fibrous insulation formed into very long pads of various 
thickness. Loose-fill insulation is typically fibers of either glass or cellulose 
blown into the floor section of the home. MHEA uses the existing insulation 
thickness to calculate the floorbelly R-value and to calculate the volume in the 
floorhelly section that is available for additional insulation. 

NOTE You may view and, if necessary, adjust the R-value MHEA assigns to all 
insulation types from within the Defaults submenu located under the 
Setup main menu. Refer to Section 4.5.2, Default Parameters, for more 
information. 
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Batt/Blanket Insulation Location 
Indicate where the batt/blanket insulation is located in the floorbelly section (see 
Figure 3-13). If the batt/blanket insulation is attached to the underside of the 
flooring, then check the attached to flooring entry. E the insulation is attached to 
the underside of the floor joists, then check the attached to floor joist entry. 
Finally, insulation that is draped below the underside of the floor joists (only 
attached around the perimeter of the belly section) is described as draped below 
floor joist in MHEA. Enter the batt/blanket insulation location for both the wing 
and belly sections. 

Insulation Attached to Flooring 

- w -  w -  w -  w -  w -  w -  W 

Insulation Attached to Floor Joists 

Insulation Draped Below Floor Joist 
(Belly Section Only) 

-10 

Figure 3-13 Batt/Blanket Insulation Location 
MHEA assumes that insulation in the wing section will either be attached to the 
underside of the flooring or will be attached to the underside of the floor joists 
(where the belly wrap is stapled to the floor joists). The draped below floor joist 
option is only available for the belly description. 

Performing an Audit 49 



NOTE If you indicated that no batt/blanket insulation exists (entry at center top of 
"Floor screen''), then MHEA will not permit you to enter a batt/blanket 
insulation location. 

NOTE MHEA assumes that all loose insulation is located at the bottom of the 
floorhelly section and that it is sitting on top of the belly wrap. 

Condition of Belly 
From your observation, enter the condition of the existing belly wrap. A belly 
wrap in good condition does not have any tears, holes, or other opening in the 
belly wrap and is tightly attached around the entire perimeter of the home. An 
average belly wrap condition has some small tears, holes, or other openings in the 
belly wrap or may not be well attached to the perimeter of the home. A belly 
wrap with large tears, holes, or other openings or is not well attached to the home 
perimeter is in poor condition. MHEA needs the belly wrap condition to calculate 
the effectiveness of existing insulation in the floorhelly section and to slightly 
adjust the cost of installing floorhelly section retrofit measures. 

Belly Cavity Configuration 
Enter the confi,wation of the belly center cavity (see Figure 3-14). Manufactured 
home belly cavities are described as being square, rounded, or flat. The belly 
cavity is the deep section that runs the length of the home and usually houses the 
main supply air duct. A square cavity configuration has vertical sides and a 
horizontal base. (Usually, the main iron support beams act as the vertical sides.) 
For a rounded belly cavity configuration, the belly wrap is draped in the middle 
portion of the home. Usually, the wrap is draped between the main iron support 
beams of the home. A flat belly cavity configuration is one in which there is no 
center belly section lower than the belly wing section. This type of belly is often 
found on homes where the main air supply duct is located between lengthwise 
floor joists or where the main supply air duct is located in the roof section. 

Maximum Depth of Belly Cavity (in.) 
Enter the maximum depth of the belly (in inches) as measured from the underside 
of the flooring to the lowest part of the belly. MHEA uses this input to calculate 
the volume of the floorhelly section to determine how much insulation can be 
added as a floorhelly retrofit measure. 
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Square Belly 

\_Belly 
Rounded Belly 

\ \ 

Flat Belly 

cDRxo6dm425a9 

Figure 3-14 Typical Manufactured home Belly Configurations 

3.2.2.2 Wall 
The "Wall" input screen contains information about the manufactured home wall 
section (see Figure 3-15). 

Wall Stud Size 
The wall stud is the wood framing between the interior and exterior manufactured 
home walls. Manufactured homes are typically constructed using standard wood 
framing. MHEA needs this information to calculate the wall R-value and the 
volume of the wall section. 
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Figure 3-15 The ‘Wall” Screen 

NOTE The nominal dimensions (those dimensions you measure with your tape 
measure) are less than the standard dimensions listed. For example, a 2” x 
4” board will actually have the dimensions of 1-3/4” x 3-1/2”. The 
options listed in MHEA are the standard dimensions used by the U.S. 
lumber industry. 

Insulation Twe  Thickness 
Enter the amount of existing insulation. By entering a value greater than 0 inches, 
you are implying that the insulation exists. If you enter a thickness of 0 inches, 
MHEA assumes that insulation of that type does not exist. 
Batt/blanket insulation is fibrous insulation formed into very long pads of various 
thickness. Loose-fill insulation is typically fibers, made either of glass or 
cellulose, blown into the wall section of the home. Foam core insulation may also 
exist in the wall section. This type of insulation is a rigid foam typically 1/4” 
thick found either between the wall studs and the interior wall or the wall studs 
and the exterior wall. MHEA uses the existing insulation thickness to calculate 
the wall R-value and to calculate the volume in the wall section that is available 
for additional insulation. 

NOTE You may view and, if necessary, adjust the R-value MHEA assigns to all 
insulation types from within the Defaults submenu located under the 
Setup main menu. Refer to Sction 4.5.2, Default Parameters, for more 
information. 
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Orientation of One Long Wall of Home 
The orientation of one long wall is the direction one wall faces. Indicate this 
orientation by checking the north, south, east, or west orientation box. MHEA 
can determine the directions other walls face from just one input. The home 
orientation is needed to calculate solar loads on the home. 

Wall Ventilation 
A manufactured home wall may be intentionally or unintentionally ventilated. A 
ventilated wall has a space for air to flow between the exterior and interior wall 
materials. One technique to determine if a wall is ventilated is to check if the wall 
insulation is dirty inside the wall cavity. Pull up slightly on the lower end of an 
exterior wall panel to check for dirty insulation. If a wall is ventilated, the 
insulation will be duty. MHEA degrades the wall R-value for ventilated walls. A 
correction factor is incorporated to account for this degradation. 

Carport/Porch Roof Dimensions 
A carport/porch roof is a shelter that has no walls and extends out from one wall 
of the manufactured home (see Figure 3-16). Often, the home occupant will park 
a car under this shelter or use it to shade an outdoor sitting area. Indicate the 
length (in feet) and width (in feet) of this carpodporch roof. The roof length is 
the dimension parallel to the manufactured home. If no carportlporch roof exists, 
then enter a length and width of zero feet. Because a carportlporch roof shades 
one manufactured home wall, the size and orientation are needed in the home 
solar gains calculations. 

Figure 3- 16 Carport/Porch Roof Dimensions 
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Carport/Porch Roof Orientation 
The orientation of the carportlporch roof is the side of the manufactured home to 
which the roof is attached. Indicate this orientation by checking the north, south, 
east, or west orientation box. Because a carport/porch roof shades one 
manufactured home wall, the size and orientation are needed in the home solar 
gains calculations. 

3.2.2.3 Window 

Describe window types, sizes, shading, and orientation on the "Window" input 
screens (see Figure 3-17). You may enter information about several different 
windows by using the Edit buttons, located at the top right of the "Window" input 
screen. The description you are viewing and the total number of descriptions you 
have entered are displayed at the top left of the "Window" input screen. 
Edit Buttons 

You may enter information about several window types by using the Edit buttons 
located at the top right comer of the screen. Only one window type may be 
described on a screen. If there are windows of different sizes, shading, glazing, or 
description, you must enter data about those windows on other screens. 
- Add 

Select the Add button to create additional window descriptions. The add 
feature is useful for describing several window types and sizes. For example, 
if both jalousie and awning windows exist in a home, enter data about these 
windows on two or more description screens. 

Delete 
To delete a window description, select the Delete button while the description 
is displayed on the screen. 

WARNING The window description that is currently displayed will be removed 
from the computer memory when you select the Delete button. Be 
caeful that you are deleting the correct description. 

View Buttons 
You can view window description screens.by selecting View buttons. You*can 
frnd this feature useful if you have entered more than one window description and 
you want to move between these descriptions. Changes can be made to the 
window description screens you have accessed from the View buttons. 
- Next 

Select the Next button to move through the screen descriptions in ascending 
order. For example, if screen 1 of 3 descriptions is displayed and you click 
the Next button, screen 2 of 3 descriptions will appear. 
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Previous 
Select the Previous button to move through the screen descriptions in 
descending order. For example, if screen 2 of 3 descriptions is displayed and 
you click the Previous button, screen 1 of 3 descriptions will appear. 

Figure 3-17 The “Window” Screen 
Description 

The window description is the type of window found in the manufactured home 
(see Figure 3-18). 

Window Tvoe 
Jalousie windows are constructed of several horizontal panes (about 6 inches 
wide) that all open at the same angle when a crank near the bottom of the window 
is turned. Jalousie windows are always single pane. Often, very large gaps 
between the glass panes exits resulting in high infiltration rates through the 
window. 
Awning windows are hinged at the top or side of the window so that when 
opened (usually by turning a crank), the glass angles out from the home exterior. 
The glass either angles down or to the side, depending on where the window is 
hinged to the home. 
Slider windows usually have two panes of glass and either one or both panes slide 
past the other when the window is opened. Both horizontal and vertical slider 
windows are found in manufactured homes. 
Fixed windows are sealed in the window frame and cannot be opened. 
Door windows are sealed in the window frame of a door and cannot be opened. 
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Figure 3-18 Typical Manufactured home Window Types 
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Sliding glass doors are large windows that extend to the floor of the home and 
can be opened to enter or exit the home. 
Skylights are $ass or plastic windows in the ceiling of the home. 

Glazing Type 
Window glazing is the type and number of glass or plastic panes that make up a 
window. 
Single-glazed windows have one plate of glass in the window frame. 
Double-glazed windows have two plates of glass in the window frame. 
Single-glazed windows with a glass storm window have a single pane of 
window glass with a second (usually removable) single pane of glass installed at 
one inch or so from the window pane. MHEA assumes that the storm window 
(second, removable pane) is installed on the interior side of the window. 
Double-glazed windows with a glass storm window are two panes of window 
glass with an additional (usually removable) single pane of glass installed at the 
one inch or so from the window pane. MHEA assumes that the storm window 
(second, removable pane) is installed on the interior side of the window. 
Single-glazed windows with a plastic storm window have a single pane of 
window glass with a second (usually removable) single pane or sheet of plastic 
installed at one inch or so from the window pane. MHEA assumes that the storm 
window (second, removable pane) is installed on the interior side of the window. 
Plastic storm window panes are 'rigid plastic panes held in a plastic, metal, or 
vinyl frame. Plastic storm window sheets are flexible plastic sheets held onto the 
window either with magnets around the outer edge of the plastic sheets or by a 
frame securely attached to the window frame. 
Double-glazed windows with a plastic storm window are two panes of window 
glass with an additional (usually removable) single pane or sheet of plastic 
installed at one inch or so from the window pane. MHEA assumes that the storm 
window (second, removable pane) is installed on the interior side of the window. 
Plastic storm window panes are rigid plastic panes held in a plastic, metal, or 
vinyl frame. Plastic storm window sheets are flexible plastic sheets held onto the 
window either with magnets around the outer edge of the plastic sheets or by a 
frame securely attached to the window frame. 

NOTE If the existing storm window is on the exterior side of the window, the 
window should be considered as not having a storm window. Typical 
manufactured home construction includes very leaky windows. The main 
benefit of storm windows is to prevent outside air from entering the home 
around the window frame. Storm windows installed on the exterior side 
of the window usually do not prevent air from leaking around a 
manufactured home window frame. 
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Dimensions 
Enter in inches the length and height of the window you are describing. 

Interior Shading 
Interior shading affects both the insulating value of the window/window shading 
combination as well as the solar loads on the home. Interior shading devices are 
interior window coverings that prevent sunlight from entering the manufactured 
home. Drapes are heavy curtains that hang in loose folds over the window. 
B h d s  or shades are lightweight window coverings that hang flat over the 
window. Both venetian blinds and roller shades are in this category. Indicate 
drapes with shades if the occupant has both on the window. Interior shading 
devices affect the amount of heat that is gained or lost through d e  manufactured 
home windows. They also slightly affect the window insulating value (U-value). 

NOTE Indicate that interior shading exists only if the devices are used most of the 
time. If the occupant usually has the shading devices pulled away from 
the window, indicate that no interior shading exists. 

Exterior Shading 
Exterior shading devices are methods of shading a window from the outside of the 
home. The solar load on the home is reduced because of exterior shading devices. 
Low-E film is a reflective film applied to the exterior surface of glass window 
panes by the window manufacturer. A sun screen is a mesh screen that is 
installed or hung on the exterior side of a window. An awning is a device that is 
mounted above a window b d  extends out from the exterior of the home. It is 
usually constructed of aluminum, fiberglass, or fabric. A carportlporch roof is a 
shelter that has no walls and extends out from one wall of the manufactured home 
(see Fipre 3-16). .Often, the home occupant will park a car under this shelter or 
use it to shade an outdoor sitting area. Indicate which of these exterior shading 
devices exist. If there is no exterior window shading, check the None box. 

Number of Windows for Each Orientation 
Indicate the number of windows on each wall of the manufactured home that fit 
the description shown on each description screen. For example, if several 
windows were located on each of the manufactured home walls, your screen 
would look like Figure 3-17. 

WARNING Do not enter information about windows on the portion of a wall 
shared with an addition. MHEA assumes all window descriptions 
are exposed to the outside. The portion of a wall shared with an 
addition is not exposed to the outside. If you describe a window on 
such a wall, MHEA will incorrectly include the window in the solar 
gains and wall R-value calculations. 
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WARNING The door description currently displayed will be removed from the 
computer,memory when you select the Delete button. Be careful 
that you delete the correct description. 

View Buttons 
You may view door description screens by selecting View buttons. You may find 
this feature useful if you have entered more than one door description and you 
wish to move between these descriptions. Changes may be made to the door 
description screens you have accessed from the View buttons. 

Select the Next button to move through the screen descriptions in ascending 
order. For example, if screen 1 of 3 descriptions is displayed and you click 
the Next button, screen 2 of 3 descriptions will appear. 

Previous 
Select the Previous button to move through the screen descriptions in 
descending order. For example, if screen 2 of 3 descriptions is displayed and 
you click the Previous button, screen 1 of 3 descriptions will appear. 

Description 
The door description identifies the type of door found in the manufactured home. 
Wood, hollow-core doors are constructed of two lightweight panels of wood 
separated by a cardboard core. 
Wood, solid-core doors are constructed of a solid piece of wood. 
Standard manufactured home doors are constructed of a metal, vinyl, or 
fiberglass skin with a solid insulating core (such as polyurethane). Most 
manufactured home doors are this type. 

Storm Door 
A storm door is a lightweight door installed outside of the manufactured home 
door. It is usually constructed of aluminum with a large portion of the door 
holding a screen, glass, or plastic window. Storm doors have very little impact on 
the energy consumption of a manufactured home other than to improve the 
insulating value (R-value) of the manufactured home door slightly. Indicate 
whether or not a storm door exists. 

Dimensions 
Enter in inches the length and width of the door you are describing. 

Number of Doors for Each Orientation 
Indicate the number of doors on each wall of the manufactured home that fit the 
description shown on each description screen. For example, if a wall had two 
standard manufactured home doors on the south wall, your screen would look like 
Figure 3-19. 
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WARNING Do not enter information about doors on the portion of a wall shared 
with an addition. MHEA assumes all door descriptions are exposed 
to the outside. The portion of a wall shared with an addition is not 
exposed to the outside. If you describe a door on such a wall, MHEA 
will incorrectly include the door in the solar gains and wall R-value 
calculations. 

3.2.2.5 Ceiling 

Enter information describing the rooflceiling section of the manufactured home on 
the “Roof Ceiling” screen (see Figure 3-20). 
Roof Twe  

Based on the roof type you indicate, MHEA can calculate the volume of the 
roofkeiling section (see Figure 3-21). AU information for roof construction for 
each type is contained within MHEA calculations. 
Flat roofs have an interior surface (interior ceiling) and an exterior surface 
(exterior roof) attached directly to either side of the wood framing, similar to wall 
construction. MHEA assumes the ceiling and roof are separated by 2” x 6” 
framing. 

Figure 3-20 The “RooEICeiling” Screen 
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Flat Roof 

Bowstring Roof 

Pitched Roof 

Figre 3-21 Typical Manufactured home Roof Configurations 
Bowstring roofs have a lightweight exterior roofing material (usually aluminum) 
that is stretched over the roof frame structure. The roof has a slight curve with the 
highest point in the middle of the home width. MHEA uses the home width and 
assumes a bowstring roof is 8 inches high at the center to calculate the volume of 
a bowstring roof section. 
Pitched roofs are sloped to a higher peak point. When viewing the home width 
from the outdoors, the roof line creates a triangle. Pitched roofs are also often 
shingled, unlike flat and bowstring roofs. MHEA uses the width of the home and 
the assumed value for the roof pitch to calculate the volume of a pitched roof 
section. 
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NOTE In some cases, there will be a second roof constructed over the original 
manufactured home roof. Enter construction information describing the 
original manufactured home roof since it is under this roof that insulation 
may be added. Enter the roof color of the second exterior roof. 

Insulation Tvpe Thickness 

Enter the amount of eesting batthlanket, loose fill, and rigid insulation. By 
entering a value greater than 0 inches, you are implying that the insulation exists. 
If you enter a thickness of 0 inches, MHEA assumes that insulation of that w e  
does not exist. 
Batthlanket insulation is fibrous insulation formed into very long pads of various 
thickness. Loose-ffl insulation is typically fibers of either glass or cellulose that 
are blown into the roofkeiling section of the home. Rigid insulation is a foam 
insulation typically a few inches thick found either directly under the roofing 
material or directly above the ceiling surface. MHEA uses the existing insulation 
thickness to calculate the rooflceiling section R-value and to calculate the volume 
in the roof/ceiling section that is available for additional insulation. 

~~~~~~~ ~ ~~~~ ~~ ~~~ 

WARNING Be careful to enter the correct insulation thickness if the insulation 
thickness is greater than the rooflceiling section height (Le., the 
thickness of the insulation if it were not compressed into the 
ceilinghoof section). Compressed insulation has a chan,+g R-value 
depending on how much it is compressed. The noncompressed 
thickness should be entered so that MHEA can calculate the correct 
R-value. 

NOTE You may view and, if necessary, adjust the R-value MHEA assigns to all 
insulation types from within the Defadts submenu located under the 
Setup main menu. Refer to Section 4.5.2, Default Parameters, for more 
information. 

Roof Color 
The color of the roof affects how solar energy impacts the heating and cooling 
loads of the home. A lightheflective roof appears white or light gray and a dark 
roof is black, dark brown, or other dark color. 

Percent Cathedral Ceiling, 
Enter the approximate floor area that is below an elevated portion of the ceiling 
(cathedral ceiling). For example, if a cathedral ceiling is above the living room 
and the living room floor area is about one third the total home floor area, the 
percent cathedral ceiling is about 33%. 



Orientation of Cathedral Ceiling Step Wall 
Some manufactured home ceilings slope up to the top of a short wall (see Fi-me 
3-22). This short wall then steps vertically down to the average home height. 
This configuration is known as a cathedral ceiling with a step wall. Enter the 
orientation that the step wall faces if one exists. If the ceiling configuration is not 
a cathedral ceiling with a step wall, then check the box next to the No Step Wall 
entry. 

‘t 

E 
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8 

Fi-oure 3-22 Manufactured home Cathedral Ceiling Step Wall 

3.2.3 Equipment 

Enter information about the manufactured home heating and cooling equipment on 
the description screens available within the Equipment submenu. Each screen asks 
for data about the manufactured home primary and secondary heating and cooling 
equipment. 

Nom You may open the manufactured home equipment description screens in 
any order to enter information about the home. You do not necessarily 
need to start with the first screen Listed and move down sequentially. It is 
recommended that you do complete the screens in a logical order so that 
you do not overlook any screens. The software calculations will run only 
if all equipment description screens have at a minimum been opened and 
accepted with the Okay button. 

3.2.3.1 Heating 

Describe the equipment used to heat the manufactured home on the heating 
equipment description screens. Some homes have more than one heating system. 
The occupants may add a second heating system because the primary system is 
unable to satisfactorily heat the home. Describe the primary heating system on the 
screen that appears when you select the Heating submenu item (see Figure 3-23), and 
describe the secondary heating system on the screen you access by selecting the 
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Secondary Equipment button found on the "Primary Heating Equipment" input 
screen. 

t 

Figure 3-23 The "Primary Heating Equipment" Screen 

NOTE Enter information on the "Primary Heating Equipment" screen, describing 
the heating system that will become the primary heating system after 
weatherizing the manufactured home. In some cases, this primary system 
may supply only a small portion of the needed heat before weatherization 
has been completed. 

NOTE If the existing furnace condition is such that products of combustion are 
allowed to enter the home, the situation is a health and safety issue that 
must be resolved before weatherization retrofit measures are installed into 
the home. After weatherizing, it is recommended to again test for 
combustion products in the living space. 

NOTE If an operating, standard manufactured home central heating system exists 
but is unable to satisfactorily heat the home, check that the duct system is 
sealed and that the furnace is operating correctly. 

Heating Equipment Twe 
Indicate the home heating equipment type. Usually, the heating equipment type is 
listed on the heating equipment nameplate. 
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Natural gas furnaces direct the hot combustion gases resulting from burning 
natural gas through a heat exchanger to heat cooler indoor air. These furnaces 
have a burner, an air duct to bring combustion air from the outside into the 
furnace closet, and an exhaust duct to release combustion gases to the outdoors. 
Electric furnaces heat air by pulling air over electric resistance heating panels. 
This furnace type differs from combustion-type furnaces in that rhere are no 
burners or ducts for combustion air supply or exhaust. 
Electric heat pumps typically remove heat from outdoor air, raise the 
temperature of this air, and deliver it to the manufactured home. Usually air-to- 
air heat pumps are found in manufactured homes. Electricity powers heat pumps 
so there are no burners or ducts for combustion air supply or exhaust. When 
operating in the heating mode, these heat pumps extract heat from outdoor air in 
order to heat indoor air. Air-to-air heat pumps cannot perform satisfactorily in 
very cold climates. 
Propane furnaces direct the hot combustion gases resulting from burning propane 
gas through a heat exchanger to heat cooler indoor air. These furnaces have a 
burner, an air duct to bring combustion air from the outside into the furnace 
closet, and an exhaust duct to release combustion gases to the outdoors. 
Oil. furnaces direct the hot combustion gases resulting from burning fuel oil 
through a heat exchanger to heat cooler indoor air. These furnaces have a burner, 
an air duct to bring combustion air from the outside into the furnace closet, and an 
exhaust duct to release combustion gases to the outdoors. 
Kerosene furnaces direct the hot combustion gases resulting from burning 
kerosene gak through a heat exchanger to heat cooler indoor air. These furnaces 
have a burner, an air duct to bring combustion air from the outside into the 
furnace closet, and an exhaust duct to release combustion gases to the outdoors. 
Coal-burning furnaces are not standard to manufactured homes. Because 
someone other than the manufacturer installed this furnace into the manufactured 
home, many types of coal-burning furnaces may exist. The furnace should be 
installed so that adequate combustion air is brought in from the outdoors and the 
products of combustion are completely removed from the living space. It is 
recommended that you conduct tests to ensure that combustion gases are not in 
the living space. 
Wood-burning heating systems are most often a supplement to the central 
manufactured home heating system and are not a standard manufactured home 
feature. They are typically fireplaces installed after the manufactured home left 
the factory. Often, when these fxeplaces were installed, sufficient combustion air 
was not also provided. When the occupant operates the fireplace with all the 
windows and doors in the manufactured home closed, the combustion air is drawn 
in through all cracks in the home, creating drafts, and often results in the occupant 
feeling colder than he would without operating the fireplace. It is recommended 
that you conduct tests to ensure that combustion gases are not in the living space 
and that you ensure adequate combustion air is able to enter the space. 
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If the occupant does not have a heating system in the manufactured home, enter 
None as the heating equipment type. 

Enter the rated input capacity (found on the equipment nameplate) for natural gas, 
electric, propane, oil, and kerosene furnaces. Enter the rated output capacity for 
heat pumps. Capacity input for coal and wood systems is not required. 

Average Indoor Temperature 
Enter the average indoor temperature during the heating season for day and night 
in degrees Fahrenheit. In most cases, enter the day and night thermostat setpoint 
temperatures. If the thermostat is not working properly or if there is no 
thermostat, enter approximate values based on measurements taken or from 
information gained from occupant interviews. 

Heating Duct Location 
Enter the location of the main supply air duct for the heating system. Usually, 
manufactured homes will have a single duct that runs along the center of the home 
or two ducts, each running along the length of the home and connected by a cross 
duct. The main supply duct will be located under the floor or above the ceiling. 
In some cases, there will not be an existing main supply air duct. If the existing 
supply air duct has been disconnected fi-om the central heating system and there 
are no plans to reconnect it, then indicate that there is no existing main supply air 
duct. 

Heatinn Duct Insulation Location 
Enter the location of the main supply air duct insulation. Insulation may be 
located only on the top of the duct, only on the bottom of the duct, or wrapped 
completely around the duct. Ductboard is a rigid insulation used to either insulate 
ducts or to create a plenum that is used as a duct. Indicate that the insulation is 
around the duct if ductboard is used. 

Percent of Total Heat Supplied (%) 

If there are two heating systems in the home, estimate the amount of heat supplied 
by the primary heating system. Enter this value as a percent of the total heat 
supplied by both the primary and secondary heating systems. The software 

.assumes that the primary system supplies 100% of the required heat unless you 
indicate otherwise. MHEA will not permit you to open the secondary heating 
equipment screen unless a value less than 100% is entered. 

Secondam EquiDment 
Click the button labeled "Secondary Equipment" to access the secondary 
heating equipment description screen. Secondary equipment is used by the 
occupant to supply heat that cannot be supplied by the primary heating system. 
Inputs on the "Secondary Heating Equipment" screen are identical to those on the 
"Primary Heating Equipment" screen, except that the Average Indoor 
Temperature and the Percent of Total Heat Supplied inputs are not required (see 
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Figure 3-24A)). MHEA assumes the indoor temperatures are the same for both the 
primary and secondary systems and MHEA calculates the percent of total heat 
supplied by the secondary system based on the input entered on the “Primary 
Heating Equipment” screen. Note that the Secondary Heating Equipment screen 
can only be accessed if the primary heating equipment supplies less than 100% of 
the required heat. 

Replacement EquiDment 

Figure 3-24A The “Secondary Heating Equipment” Screen 
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Figure 3-24B The "Replacement Heating Equipment" Screen 

3.2.3.2 Cooling 

Describe the equipment used to cool the manufactured home on the Cooling 
Equipment description screens. Some manufactured homes have more than one 
cooling system. Usually, a second cooling system is added by the occupants because 
the primary system is unable to satisfactorily cool the home. Describe the primary 
cooling system on the screen that appears when you select the Cooling submenu item 
(see Figure 3-25), and describe the secondary cooling system on the screen you 
access by selecting the Secondary Equipment button found on the "Primary 
Cooling Equipment" input screen (see Figure 3-26). Notice that the primary and 
secondary cooling equipment screens are nearly identical. 

NOTE Enter information on the "Primary Cooling Equipment" screen describing 
the cooling system that will become the primary heating system after 
weatheriziig the manufactured home. In some cases, this primary system 
may supply only a small portion of the needed cooling before 
weatherization has been completed. 

NOTE If an operating, standard manufactured home central cooling system exists 
but is unable to satisfactorily cool the home, check that the duct system is 
sealed and that the cooling system is operating correctly. 
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Figure 3-25 The “Primary Cooling Equipment” Screen 
- 

I 
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Cooling Equipment Tvoe 
Indicate the home cooling equipment type. 
Evaporative coolers usually are a rectangular box mounted on the roof of the 
home. Air is cooled when it is pulled through wetted pads before being blown 
into the home from one central supply air location. There is no ductwork with 
evaporative coolers. 
Central air conditioners have a cooling coil located inside the home (often with 
the central furnace unit) and a condenser found outdoors near the home. Central 
air-conditioning systems distribute cool air through ducts, usually the same ducts 
through which heated air is supplied to the home. 
Room air conditioners are either installed in a window or mounted through an 
exterior wall. This type of air conditioner is designed to cool only one room of 
the home. There is no ductwork with room air conditioners. 
Electric heat pumps remove heat from one substance and delivers the heat to a 
second substance. Usually air-to-air heat pumps are found in manufactured 
homes. When operating in the cooling mode, these heat pumps remove heat from 
the air inside the home and deliver the heat to the outdoors. Note that heat pumps 
cannot perform satisfactorily in very hot climates. 
If the occupant does not have a cooling system in the manufactured home, enter 
None as the cooling equipment type. 

Rated Total Capacity 
Read the energy input from the nameplate attached to the cooling equipment. No 
capacity input is alloqed if the cooling equipment is an evaporative cooler or if no 
cooling equipment exists. 

Rated Coefficient of Performance COP 
Read the equipment-rated COP from the nameplate attached to the cooling 
equipment. If the COP is not included on the nameplate, look up the COP in a 
cooling equipment blue book or other literature that includes typical COP values 
for various cooling equipment types and ages. 

Enter the average indoor temperature during the cooling season for day and night 
in degrees Fahrenheit. If a thermostat exists, enter the day and night thermostat 
setpoint temperatures. Tf the thermostat is not working properly or if there is no 
themostat, enter approximate values based on measurements taken or from 
information gained from occupant interviews. 

Average Indoor Temperature 

Cooling Duct Location 
Enter the location of the main supply air duct for the cooling system. Usually, 
manufactured homes will have a single duct that runs along the center of the home 
or two ducts, each running along the length of the home, connected by a cross 
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duct. The main supply duct will be located under the floor or above the ceiling. 
In some cases, there will not be an existing main supply air duct. 

Cooling Duct Insulation Location 
Enter the location of the main supply air duct insulation. Insulation may be 
located only on the top of the duct, only on the bottom of the duct, or wrapped 
completely around the duct. Ductboard is a rigid insulation used to either insulate 
ducts or to create a plenum that is used as a duct. Indicate that the insulation is 
around the duct if ductboard is used. 

Auproximate Area of Home Cooled by Room Air Conditioner (%I 
Enter the approximate home floor area (in percent) cooled by the room air 
conditioner. For example, if a room air conditioner cools the living room and the 
living room floor area is about one-third the total home floor area, the 
approximate home area cooled by the room air conditioner is 33%. If there is no 
existing room air conditioner, then do not enter a value in this box. 

Secondarv Equipment 
Click the button labeled "Secondary Equipment" to access the Secondary 
Cooling Equipment description screen. Secondary equipment is used by the 
occupant to supply cooled air that cannot be supplied by the primary cooling 
system. Inputs on the "Secondary Cooling Equipment" screen are identical to 
those on the "Primary Cooling Equipment" screen except the Average Indoor 
Temperature inputs are not required. MHEA assumes the indoor temperatures are 
the same for both the primary and secondary systems. 

3.2.4 Manufactured home Additions 

Additions are defrned as any add-on structure that is conditioned by the manufactured 
home heating and cooling systems (see Fiawe 3-27). Additions cannot be separated 
from the manufactured home (for example, by closing the door to an entrance 
vestibule). Additions that are part of the living space must be included in the energy 
calculations of the home. If the addition can and usually is separated from the 
manufactured home, it should not be included when evaluating weatherization retrofit 
measures for the manufactured home. 

NOTE You may open the "Manufactured home Addition" description screens in 
any order to enter information about the addition. You do not necessarily 
need to start with the screen that is listed frrst and move down 
sequentially. It is recommended that you complete the screens in a logical 
order so that you do not overlook any screens. If there is not an addition, 
then you do not need to work through these screens. 
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Figure 3-27 Typical Manufactured home Addition 

3.2.4.1 Addition Floor 
Enter information describing the floor section of the addition on this screen (see 
Figure 3-28). You will notice that the "Addition Floor" screen is very similar to the 
"Floor" screen found from within the Construction submenu (see Section 3.2.2.1). 

Figure 3-28 The "Addition Floor" Screen 
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Floor Dimensions 
Enter the dimensions of the addition floor (see Figure 3-29). The floor length is 
the dimension parallel to the wall shared with the manufactured home and the 
floor width is the dimension perpendicular to the wall shared with the 
manufactured home. 

NOTE In order for MHEA to recognize that there is an addition, you must enter 
floor dimensions. If you complete other addition description screens but 
do not enter floor dimensions, MEiEA will assume that an addition does 
not exist. 

CDRH06Am42516 

Fiawe 3-29 Manufactured home Addition Dimensions 
Floor Joist Direction 

The floor joist is the wood framing that supports the interior floor (see Figure 3- 
30). Enter the direction the floor joists are installed. Lengthwise floor joists are 
installed parallel to the long dimension (lene&) of the addition. Widthwise floor 
joists are installed parallel to the short dimension (width) of the addition. The 
floor joist direction is needed to calculate ,more accurately the volume of the 
addition floor section and to calculate more accurately the R-value of the floor. 

74 Manufactured Home Energy Audit 



Widthwise Addition Floor Joists 

Lengthwise Addion Floor Joists 
CD-RHWA0342517 

Figure 3-30 Manufactured home Addition Floor Joist Direction 
BattfBlanket Direction 

Indicate if batt/blanket insulation exists and if it does exist, the direction in which 
. it is installed. Battlblanket insulation that has been installed lena$.hwise is parallel 
to the long dimension (length) of the addition. Insulation that has been installed 
widthwise is parallel to the short diinension (width) of the addition. The 
insulation direction is needed to calculate more accurately the R-value of existing 
battlblanket insulation that is attached to the flooring or floor joist. Place a check 
next to the option indicating the insulation location as the Batt/Blanket Insulation 
Location input on the "Addition Floor" input screen. 
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NOTE You may view and, if necessary, adjust the R-value MHEA assigns to all 
insulation types from within the Defaults submenu located under the 
Setup main menu. Refer to Section 4.5.2, Default Parameters, for more 
infomation. 

Indicate whether or not a skirt exists around the exterior of the addition. Research 
has shown that skirting only protects the addition floor from exposure to the wind. 
If skiaing exists, MHEA adjusts the exterior air R-value to account for the 
absence of wind when the total R-value of the floor section is calculated. 

Floor Joist Size 
The floor joist is the wood framing that supports the interior floor. Additions are 
typically constructed using standard wood framing. Indicate the dimensions of 
the floor joists. MHEA needs this information to calculate the floor R-value and 
the volume addition floor section. 

NOTE The nominal 'dimensions (those dimensions you measure with your tape 
measure) are less than the standard dimensions listed. For example, a 2" x 
4" board will actually have the dimensions of l-3/4" x 3-1/2". The 
options listed in MHEA are the standard dimensions used by the U.S. 
.lumber industry. 

Insulation TvDeAXckness 
Enter the amount of existing batt/blanket and loose-fa insulation. By entering a 
value greater than 0 inches, you are implying that the insulation exists. If you 
enter a thickness of 0 inches, MHEA assumes that insulation of that type'does not 
exist. Enter the amount of existing insulation. 
Batthlanket insulation is fibrous insulation formed into very long pads of various 
thickness. Loose-fill insulation is typically fibers of either glass or cellulose 
blown into the floor section of the addition. MHEA uses the existing insulation 
thickness to calculate the floor R-value and to calculate the volume in the floor 
section that is available for additional insulation. 

NOTE You may view and, if necessary, adjust the R-value MHEA assigns to all 
insulation types from within the Defaults submenu located under the 
Setup main menu. Refer to Section 4.5.2, Default Parameters, for more 
information. 

Batt/Blanket Insulation Location 
Indicate where the batthlanket insulation is located in the addition floor. If the 
battlblanket insulation is attached to the underside of the flooring, then check the 
attached to flooring entry. If the insulation is attached to the underside of the 
floor joists, then check the attached to floor joist entry. 

. 

76 Manufactured Home Energy Audit 





varying height, enter the maximum and minimum wall heights. Lf the walls are all 
the same height, enter the same value in both the maximum and minimum height 
entry boxes. 

Wall Confi,wation 
Enter the approximate wall confi,wation by checking the appropriate box. The 
ceiling slopes down from the interior wall (wall shared with the manufactured 
home) to the opposite exterior wall if the maximum wall height is at the interior 
wall. The maximum wall height is the center of the addition if, from the interior 
of the addition, the ceiling peaks along the center of the addition and slopes down 
towards the exterior walls that are perpendicular to the manufactured home. 
Finally, an addition with a flat ceiling has walls that are all the same height. 
MHEA will only accept a flat ceiling wall confi,wation if the minimum and 
maximum wall heights are the same. 

Wall Stud Size 
The wall stud is the wood fiaming that is between the interior and exterior 
addition walls. Additions are typically constructed using standard wood framing. 
MHEA needs this information to calculate the wall R-value and the volume of the 
wall section. 

NOTE The nominal dimensions (those dimensions you measure with your tape 
measure) are less than the standard dimensions listed. For example, a 2" x 
4" board will actually have the dimensions of 1-3/4" x 3-1/2". The 
options listed in MHEA are the standard dimensions used by the U.S. 
lumber industry. 

Insulation TvPe Thickness 
Enter the amount of existing insulation. By entering a value greater than 0 inches, 
you are implying that the insulation exists. If you enter a thickness of 0 inches, 
MEEA assumes that insulation of that type does not exist. 

Batt/blanket insulation is fibrous insulation formed into very long pads of various 
thickness. Loose-fill insulation is typically fibers, made either of glass or 
cellulose, blown into the wall section of the addition. Foam core insulation may 
also exist in the wall section. This type of insulation is a rigid foam typically 
1/4" thick found either between the wall studs and the interior wall or the wall 
studs and the exterior wall. MHEA uses the existing insulation thickness to 
calculate the wall R-value and to calculate the volume in the wall section that is 
available for additional insulation. 

NOTE You may view and, if necessary, adjust the R-value MHEA assigns to all 
insulation types fiom within the Defaults submenu located under the 
Setup main menu. Refer to Section 4.5.2, Default Parameters, for more 
information. 
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Wall Ventilation 

An addition wall may be intentionally or unintentionally ventilated. A ventilated 
wall has a space for air to flow betweerl the exterior and interior wall materials. 
The wall insulation is dirty inside ventilated walls. Pull up slightly on the lower 
end of an exterior wall panel to check for dirty insulation. If a wall is ventilated, 
the wall R-value is degraded. MHEA incorporates a correction factor to account 
for this degradation. 

3.2.4.3 Addifion Window 

Describe window types, sizes, shading, and orientation on the "Addition Window" 
input screens (see Figure 3-32). You may enter information about several different 
windows by using the Edit buttons, located at the top right of the "Addition Window" 
input screen. The description you are viewing and the total number of descriptions 
you have entered are displayed at the top left of the "Addition Window" input screen. 

Figure 3-32 The "Addition Window" Screen 
Edit Buttons 

You may enter information about several window types by using the Edit buttons 
located at the top right comer of the screen. Only one window type may be 
described on a screen. If there are windows of different sizes, shading, glazing, or 
description, you must enter data about those windows on other screens. 
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- Add 
Select the Add button to create additional window descriptions. The add 
feature is useful for describing several window types and sizes. For example, 
if both jalousie and awning windows exist in a home, enter data about these 
windows on two or more description screens. 

Delete 
To delete a window description, select the Delete button while the description 
is displayed on the screen. 

WARNING The window description that is currently displayed will be removed 
from the computer memory when you select the Delete button. Be 
carefid that you are deleting the correct description. 

View Buttons 
You may view window description screens by selecting View buttons. You may 
find this feature useful if you have entered more than one window description and 
you wish to move between these descriptions. Changes may be made to the 
window description screens you have accessed from the View buttons. 

Select the Next button to move through the screen descriptions in ascending 
order. For example, if screen 1 of 3 descriptions is displayed and you click 
the Next button, screen 2 of 3 descriptions will appear. 

Previous 
Select the Previous button to move through the screen dqscriptions in 
descending order. For example, if screen 2 of 3 descriptions is displayed and 
you click the Previous button, screen 1 of 3 descriptions will appear. 

Description 
The window description is the type of window found in the addition (see Figure 

Jalousie windows are constructed of several horizontal panes (about 6 inches 
. wide) that all open at the same angle when a crank near the bottom of the window 

is turned. Jalousie windows are always single pane. Often, very large gaps 
between the glass panes exists, resulting in high infiltration rates through the 
window. 

3- 18). 

Awning windows are hinged at the top or side of the window so that when 
opened (usually by turning a crank), the glass angles out from the addition 
exterior. The glass either angles down or to the side, depending on where the 
window is hinged to the home. 
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Slider windows usually have two panes of glass and either one or both panes slide 
past the other when the window is opened. Both horizontal and vertical slider 
windows are found in additions. 
Fixed windows are sealed in the window frame and cannot be opened. 
Door windows are sealed in the window frame of a door and cannot be opened. 

1 

Sliding glass doors are large windows that extend to the floor of the addition and 
can be opened to enter or exit the addition. 
Skylights are glass or plastic windows in the ceiling of the addition. 

Glazing Tvue 
Window glazing is the type and number of glass or plastic panes that make up a 
window. 
Single-glazed windows have one plate of glass in the window frame. 
Double-glazed windows have two plates of glass in the window frame. 
Single-glazed windows with a glass storm window have a single pane of 
window glass with a second (usually removable) single pane of glass installed at 
one inch or so from the window pane. MHEA assumes that the storm window 
(second, removable pane) is installed on the interior side of the window. 
Double-glazed windows with a glass storm window are two panes of window 
glass with an additional (usually removable) single pane of glass installed at one 
inch or so from the window pane. MHEA assumes that the storm window 
(second, removable pane) is installed on the interior side of the window. 
Single-glazed windows with a plastic storm window have a single pane of 
window glass with a second (usually removable) single pane or sheet of plastic 
installed at one inch or so from the window pane. MHEA assumes that the storm 
window (second, removable pane) is installed on the interior side of the window. 
Plastic storm window panes are rigid plastic panes held in a plastic, metal, or 
vinyl kame. Plastic storm window sheets are flexible plastic sheets held onto the 
window either with magnets around the outer edge of the plastic sheets or by a 
frame securely attached to the window frame. 
Double-glazed windows with a plastic storm window are two panes of window 
glass with an additional (usually removable) single pane or sheet of plastic 
installed at the one inch or so from the window pane. MHEA assumes that the 
storm window (second, removable pane) is installed on the interior side of the 
window. Plastic storm window panes are rigid plastic panes held in a plastic, 
metal, or vinyl frame. Plastic storm window sheets are flexible plastic sheets held 
onto the window either with magnets around the outer edge of the plastic sheets or 
by a frame securely attached to the window frame. 
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NOTE If the existing storm window is on the exterior side of the window, the 
window should be considered as not having a storm window. Typical 
addition construction inciudes very leaky windows. The main benefit of 
storm windows is to prevent outside air from entering the addition around 
the window frame. Storm windows installed on the exterior side of the 
window usually do not prevent air from leaking around a addition window 
li-me. 

Dimensions 
Enter in inches the length and height of the window you are describing. 

Interior Shading 
Interior shading affects both the insulating value of the window/window shading 
combination as well as the solar loads on the addition. Interior shading devices 
are interior window coverings that prevent sunlight from entering the addition. 
Drapes are heavy curtains that hang in loose folds over the window. Blinds or 
shades are lightweight window coverings that hang flat over the window. Both 
venetian blinds and roller shades are in this category. Indicate drapes with shades 
if the occupant has both on the window. Interior shading devices affect the 
amount of heat that is gained or lost through the manufactured home windows. 
They also slightly affect the window insulating value U-value. 

NOTE Indicate that interior shading exists only if the devices are used most of the 
time. If the occupant usually has the shading devices pulled away from 
the window, indicate that no interior shading exists. 

Exterior Shading 
Exterior shading devices are methods of shading a window from the outside of the 
addition. The solar load on the addition is reduced’ because of exterior shading 
devices. Low E-film is a reflective film applied to the exterior surface glass 
window panes by the window manufacturer. A sun screen is a mesh screen that is 
installed or hung on the exterior side of a window. An awning is a device that is 
mounted above a window and extends out from the exterior of the home. It is 
usually constructed of aluminum, fiberglass, or fabric. A carport/porch roof is a 
shelter that has no walls and extends out from one wall of the addition. Often, the 
home occupant will park a car under this shelter or use it to shade an outdoor 
sitting area. Indicate which of these exterior shading devices may exist. If there 
is no exterior window shading, then check the None box. 

Number of Windows for Each Orientation 
Indicate the number of windows on each wall of the addition that fit the 
description shown on each description screen. 
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WARNING The door description that is currently displayed will be removed from 
the computer memory when you select the Delete button. Be careful 
that you are deleting the correct description. 

View Buttons 
You may view door description screens by selecting View buttons. You may find 
this feature useful if you have entered more than one door description and you 
wish to move between the descriptions. Changes may be made to the door 
description screens you have accessed from the View buttons. 
- Next 

Select the Next button to move through the screen descriptions in ascending 
order. For example, if screen 1 of 3 descriptions is displayed and you click 
the Next button, screen 2 of 3 descriptions will appear. 

Previous 
Select the Previous button to move through the screen .descriptions in 
descending order. For example, if screen 2 of 3 descriptions is displayed and 
you click the Previous button, screen 1 of 3 descriptions will appear. 

Description 
The door description is the type of door found in the addition. 
Wood, hollow-core doors are constructed of two lightweight panels of wood 
separated by a cardboard core. 
Wood, solid-core doors are constructed of a solid piece of wood. 
Standard manufactured home doors are constructed of a metal, vinyl, or 
fiberglass skin with a solid insulating core (such as polyurethane). 

Storm Door 
A storm door is a lightweight door that is installed outside of the addition door. 
This door is usually constructed of aluminum with a large portion of the door 
holding a screen, glass, or plastic window. Storm doors have very little impact on 
the energy consumption of a manufactured home other than to improve the R- 
value of the manufactured home door slightly. Indicate whether or not a storm 
door exists. 

Dimensions 
Enter in inches the length and width of the door you are describing. 

Number of Doors for Each Orientation 
Indicate the number of doors on each wall of the addition that fit the description 
shown on each description screen. 
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3.2.4.5 Addition Ceiling 

Enter information describing the roofkeiling section of the addition on the “Addition 
Ceiling” screen (see Figure 3-34). 

Figure 3-34 The “Addition Roof7Ceiling” Screen 
RooUCeiling Joist Size 

The rooflceiling joist is the wood framing that supports the interior ceiling and the 
exterior roof. Additions are typically constructed using standard wood framing. 
Indicate the dimensions of the roofkeiling joists. MHEA needs this information 
to calculate the roofkeiling R-value and the volume addition roofkeiling section. 

WARNING The nominal dimensions (those dimensions you measure with your 
tape measure) are less than the standard dimensions listed. For 
example, a 2” x 4” board will actually have the dimensions of 1-3/4” 
x 3-1/2”. The options listed in MHEA are the standard dimensions 
used by the U.S. lumber industry. 

Roof Color 
The color of the roof affects how solar energy impacts the heating and cooling 
loads of the addition. A lighdreflective roof appears white or light gray and a 
dark roof is black, dark brown, or other dark color. 
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Insulation Tvue Thickness 

Enter the amount of existing batt/blanket, loose-fill, and rigid insulation. By 
entering a value greater than 0 inches, you are implying that the insulation exists. 
If you enter a thickness of 0 inches, MHEA assumes that insulation of that type 
does not exist. 
Batt/blanket insulation is fibrous insulation formed into very long pads of various 
thickness. Loose-fill insulation is typically fibers of either glass or cellulose 
blown into the roofkeiling section of the addition. Rigid insulation is a foam 
insulation typically a few inches thick found either directly under the roofing 
material or directly above the ceiling surface. MHEA uses the existing insulation 
thickness to calculate the rooflceiling R-value and to calculate the volume in the 
rooflceiling section that is available for additional insulation. 

WARNING Be careful to enter the correct insulation thickness if the insulation 
thickness is greater than the roofkeiling section height (ie., the 
thickness of the insulation if it were not compressed into the 
ceilinghoof section). Compressed insulation has a changing R-value 
depending on how much it is compressed. The noncompressed 
thickness should be entered so that MHEA can calculate the correct 
R-value. 

NOTE You may view and, if necessary, adjust the R-value MHEA assigns to a l l  
insulation types from within the Defaults submenu located under the 
Setup main menu. Refer to Section 4.5.2, Default Parameters, for more 
information. 

3.2.5 Billing Data ! 

Enter actual billing data for the energy sources consumed by the manufactured home 
on the screens that become available when you select the billing data submenu item 
(see Figure 3-35). I€ the calculations are evaluated using the data you enter on the 
billing data screens, MHEA will adjust the results to more accurately represent the 
energy consumption of the particuiar manufactured home you are auditing. 

After you have selected the Billing Data submenu item, a second submenu will 
appear on your screen. Select the Electricity submenu to enter information about 
monthly electrical consumption. If the manufactured home heating systems are 
combustion-type systems, select the Primary Heating Fuel submenu to enter billing 
data about the fuel used by the home primary and secondary heating systems. 

Use any of the methods described in Section 1.3, Navigating Through MHOEA, to 
select menu items and enter data for the billing data screens. 
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Figure 3-35 Billing Data Submenu Tree 

NOTE The billing data adjustment feature applies only to those situations where 
the fuel consumption is known. In most cases, monthly utility bills will 
record this information. If a bulk fuel such as fuel oil, propane, wood or 
other fuel is used, then the manufactured home occupant may be able to 
help determine when and how much fuel was purchased or restocked. 

You are not required to enter the manufactured home billing data before 
running the MHEA calcuJations. Adjusting the calculation results based 
on actual recorded energy use is an optional MHEA feature. 

3.2.5.1 Electricify 

Enter billing data on the screen that is available by selecting the Electricity submenu 
option (see Figure 3-36). 
Month 

Enter the number of the first month in the bill year. The months are numbered 
beginning with January = 1, February = 2, and so on. You may begin with any 
month. You must enter a full year’s utility bill data. 

Dav 
Enter the day of the month the billing data is recorded. If the utility records 
billing information on the 15th day of each month, enter 15 in the Day column. 
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Figure 3-36 The “Electric Utility Bill Data,’ Screen 
# of Davs 

Enter the number of days in the fmt billing month. For example, if the first 
billing month extends from January 15 to February 15, enter 31 in the number of 
days editable field. 
- kwh 

Enter the monthly electricity consumption as recorded by the utility. 
information should be entered in units of kwh. 

This 

Denee-Daw CDD) 
Enter the degree-days as they are recorded by the utility for the billing period you 
are evaluating. This is not a required entry. The degree-days are shown on the 
results screen for your information only and do not affect the calculations. 
MHEA uses degree-days calculated from weather data for an “average” year. 
You may be interested in comparing the degree-days used in MHEA calculations 
with those that actually occurred for the year you entered utility bill information, 
especially if the information you entered was for an unusually warm or cold year. 

NOTE Degree-day entries are optional. They are not required to complete 
MHEA energy consumption and economic calculations. 

Base Temuerature for Degree-Davs 
Enter the base temperature for which degree-days are to be calculated. A degree- 
day is the difference between a base mean daily temperature and the actual mean 
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daily temperature. Heating degree-days occur when the actual mean daily 
temperature is less than the base temperature. Cooling degree-days occur when 
the actual mean daily temperature is greater than the base temperature. Typically, 
659; is considered an appropriate base temperature for most climates. 

Calculate Base Load 
After you have entered monthly energy consumption information, select this 
button to estimate a base load. A base load is the average monthly energy 
consumption that is required to meet constant loads for water heating, cooking, 
lighting, and other internal loads. MHEA subtracts the base load from the 
monthly electricity consumption to estimate the electricity consumed by the 
heating and cooling systems. 

Base Load 
The base load is the energy required to operate the domestic hot water heater, 
lights, cooking, clothes washing, and to operate other household appliances that 
are used throughout the year. For example, if the heating equipment uses natural 
gas and an electric cooling system exists, the electric base load can be estimated 
by averaging the monthly electricity consumption during the winter months. 

NOTE If you have calculated the base load by some method other than an MHEA 
base load estimate or if you have measured the base load, you may enter 
that value in the Self-Determined Base Load editable field (bottom of the 
"Billing Data" screen). If a self-determined base-load value has been 
entered, MHEA will use this value in the calculations and not the value 
obtained by selecting the Calculate Base Load button. 

Base-Load Units 
The Units associated with the base load calculated by MHEA are displayed in the 
Base Load Units view box. The Units will be kWh. 

Calculated Base Load 
MHEA displays the calculated base load in the Calculated Base Load view box. 
You must select the Calculate Base Load button (see description above) to 
initiate MHEA base load calculation. 

Self-Determined Base Load 
Enter a base load that you have obtained from a calculation, measurement, or 
some other means other than that provided with MHEA. A base load is the 
average monthly energy consumption that is required to meet constant loads for 
water heating, cooking, lighting, and other internal loads. Be sure to enter a base 
load only for electricity and not include a base load for other fuels. MHEA 
subtracts the base load from the monthly electricity consumption to estimate the 
electricity consumed by the heating and cooling systems. 
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NOTE It is recommended that you enter a self-determined base-load value if the 
manufactured home has operating electric heating and cooling systems. 
Because electricity is used in both the heating and cooling seasons, MHEA 
may overestimate the base load from the information provided on the 
“Billing Data” screens. This high base-load estimate may translate to 
lower (Savings to Investment) SIR values calculated for the recommended 
weatherization measures. 

, 

NOTE If a self-determined base load value has been entered, MHEA will use this 
value in the calculations and not the value obtained by selecting the 
Calculate Base Load button. 

3.2.5.2 Heating 

Enter billing data on the screens that are available by selecting the Primary Heating 
Fuel submenu option of the manufactured home heating system. Use this screen 
when the heating system@) is a combustion-type system (see Fiap-e 3-37). 

Figure 3-37 The “Primq Heating Fuel” Screen 
Month 

Enter the number of the frrst month in the bill year. The months are numbered 
beginning with January = 1, February = 2, and so on. You may begin with any 
month. You must enter a full year’s utility bill data. 
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Non-monthly bulk fuel deliveries such as liquefied petroleum gas (LPG) may be 
entered on this screen as well. Enter information (month, day, amount, etc.) for 
the first delivery to be considered on the first row. Enter information about the 
second (next in chronological order) delivery in the next row. Continue in this 
manner for additional deliveries. MHEA interprets the first zero entry for month 
or day as the end of a billing infomation data you are entering. If you enter bulk 
fuel data that spans a partial year, MHEA will adjust the annual results based on 
that partial period only. 
If secondary fuel records are to be considered, you will need to convert this 
information to energy units and bill periods consistent with primary fuel billing 
data and add the two data sets together. 

Enter the day of the month the billing data is recorded. If the utility records 
billing information on the 15th day of each month, enter 15 in the Day column. 

# of Davs 
Enter the number of days in the first billing month. For example, if the first 
billing month extends from January 15 to February 15, enter 31 in the number of 
days editable field. 

ThermskWh 
Enter the monthly energy consumption as recorded by the utility. If the heating 
system is natural gas, enter the consumption on the natural gas heating screen in 
units of therms. Energy units (e.g., gallons of propane) for other heating fuels 
will need to be converted into therms. 

Heating Demee-Days (HDD) 
Enter the heating degree-days as they are recorded by the utility for the billing 
period you are evaluating. This is not a required entry. The degree-days are 
shown on the results screen for your information only and do not affect the 
calculations. MHEA uses degree-days calculated from weather data for an 
“average” year. You may be interested in comparing the degree days used in 
MHEA calculations with those that actually occurred for the year you entered 
utility bill information, especially if the information you entered was for an 
unusually warm or cold year. 

NOTE Heating degree-day entries are optional. They are not required to 
complete MHEA energy consumption and economic calculations. 

Base Temperature for DD 
Enter the base temperature for which degree-days are to be calculated. A degree- 
day is the difference between a base mean daily temperature and the actual mean 
daily temperature. Heating degree-days occur when the actual mean daily 
temperature is less than the base temperature. Cooling degree-days occur when 
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the actual mean daily temperature is greater than the base temperature. Typically, 
65OF is considered an appropriate base temperature for most climates. 

Calculate Base Load 
After you have entered monthly energy consumption information, select this 
button to estimate a base load. A base load is the average monthly energy 
consumption that is required to meet constant loads for water heating, cooking, 
lighting, and other internal loads. MHEA subtracts the base load from the 
monthly energy consumption to estimate the energy consumed by the heating 
system. 

Base Load 
The base load is the energy required to operate the domestic hot water heater, 
lights, cooking, clothes washing, and to operate other household appliances that 
are used throughout the year. For example, if the heating equipment uses natural 
gas, the base natural gas load can be estimated by avera,Oing the monthly natural 
gas consumption during the summer months. 

NOTE If you have calculated the base load by some method other than MHEA 
base-load estimate or if you have measured the base load, you may enter 
that value in the Self-Determined Base Load editable field (bottom of the 
"Billing Data" screen). If a self-determined base load value has been 
entered, MHEA will use this value in the calculations and not the value 
obtained by selecting the Calculate Base Load button. 

NOTE MHEA's determination of a base load is of limited accuracy with bulk fuel 
data since seasonal and monthly trends are not known. Provide a "user- 
determined" base-load value to override MHEA's value, if additional 
base-load information is available. 

Base-Load Units 
The units associated with the base load calculated by MHEA are displayed in the 
Base Load Units view box. The units will be either themdmonth or kWmonth. 

Calculated Base Load 
MHEA displays the calculated base load in the Calculated Base Load view box. 
You must select the Calculate Base Load button (see description above) to 
initiate MHEA base-load calculation. 

Self-Determined Base Load 
Enter a base load that you have obtained from a calculation, measurement, or 
some other means than that provided with MHEA. A base load is the average 
monthly energy consumption required to meet constant loads for water heating, 
cooking, lighting, and other internal loads. Be sure to enter a base load only for 
the power source for which billing data has been entered. MHEA subtracts the 
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base load from the monthly energy consumption to estimate the energy consumed 
by the heating system. 

NOTE It is recommended that you enter a self-determined base-load value if the 
manufactured home has operating electric heating and cooling systems. 
Because electricity is used in both the heating and cooling seasons, MHEA 
may overestimate the base load from the information provided on the 
“Billing Data” screens. This high base-load estimate may translate to 
lower SIR values calculated for the recommended weatherization 
measures. 

NOTE If a self-determined base-load value has been entered, MHEA will use this 
’ value in the calculations and not the value obtained by selecting the 

Calculate Base Load button. 

3.2.6 Comments 

Use the comment screen to record miscellaneous information. Open this screen by 
selecting the Comments option from within the Inputs menu. Type new information 
or edit existing comments using the keyboard. The comments already entered may be 
displayed, but not edited, by selecting the Comments submenu found within the View 
main menu. Select the Print submenu found within the File main menu to print the 
comments (see Figure 3-38). 
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Figure 3-38 The “Edit Comments” Screen 
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3.3 Edit the input Data 
You may reenter the input screens at any time to revise the input data. For example, 
you may decide some time after you initially entered the description data to adjust the 
input files. To do this, open the project file to be revised using the Open submenu 
item found within the File menu (see Section 3.1.2, Open) and go to the screen or 
screens you want to update. After you have made your changes, select the Okay 
button on the screen to store your changes. Then rerun the calculations so that the 
changes are included in the calculation results. 

3.4 Perform Energy Use and Cost Analysis 
After entering all the required input data, select the Run menu item (center of Main 
Menu Bar) to activate the program calculations (see Figure 3-39). Select either the 
Run with Weather or the Run with Billing Data from the Run submenu list to initiate 
M€iEA calculations. You may use any of the methods described in section 1.3, 
Navigating Through MHEA, to select the Run menu and submenu items. 
If information is missing or if a required input screen was not completed, MHEA will 
display a message asking for the missing data before the calculations are initiated. 
You may view the results at any time without rerunning the program calculations. If 
you changed any of the input or setup data, then you must rerun the calculations to 
update the results. Results may be viewed by selecting the View menu item. 

Figure 3-39 Run Menu Options 
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3.4.1 Run with Weather 

Select the Run with Weather submenu option to initiate MHEA calculations using 
weather data for the city you specified on the Weather Data screen (see Section 4.7, 
Choose a City). 

3.4.2 Run with Billing Data 

Select the Run with.Billing Data submenu option to initiate MHEA calculations that 
will use the utility billing information you entered on the “Billing Data” screens (see 
Section 3.2.5, Billing Data). 

NOTE When you enter billing data and have MHEA calculate a base-load usage, 
MHEA may not be able to iden@ a unique base-level value. If a warning 
message appears (see Fi-we 3-40), you should review the utility data and 
supply your best estimate in the “self-determined base load” box on the 
billing data entry screen. Also note that if you have entered electric utility 
bill information for both heating and cooling, you should supply your best 
“self-determined base load” estimate separately for the heating and 
cooling seasons. 

Figure 3-40 MHEA Run Message Screen 
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3.5 View the Reports 
You may display a summary of the input data, energy and economic calculation 
results, and comments on the computer screen by selecting submenus from within the 
View main menu item (see Figure 3-41). Select the menu and submenu items using 
any of the methods described in Section 1.3, Navigating Through MHEA. 

Nom You cannot edit information on any of the screens displayed in the View 
menu. You must reopen input and setup screens to revise the information. 
After revising input and setup data, rerun the calculations to include the 
new information. 

Fiewe 341 View Menu Options 

3.5.1 Inputs 

The data you entered on the input screens are displayed in a condensed form when 
you select the Input submenu option found within the View main menu. You can 
only view the display. You cannot change the data on these screens. Reopen the 
appropriate input screen if changes are necessary (see Section 3.3, Edit the Input 
Data). 
The View Inputs screen has a scroll bar along the right side of the screen so you can 
view a l l  the input information (see Section 1.5.5, Scroll Bars). Activate the scroll bar 
using either the mouse or the keyboard as was described in Section 1.3, Navigating 
Through the MHEA. 
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3.5.2 Results 

Display the energy use and cost analysis calculation results by selecting the Results 
submenu found within the View main menu item. The calculation results are 
divided between four screens: the "Savings", "Savings-to-Investment Ratio", "Costs", 
"Billing", and "Sizing" screens. Each of these screens is described in more detail in 
Sections 3.5.2. 
All results screens have a scroll bar along the right side of the screen. If there is more 
information than can be displayed in one screen, use the methods for activating the 
scroll bar that were described in Section 1.5.5, Scroll Bars, to view the entire results 
screen. 
On the "Savings", "SIR", and "Costs" results screens, the recommended retrofit 
measures are listed according to their SIR, with the retrofit having the highest SIR 
listed first. There are two exceptions to this ordering. It is assumed by MHEA that 
duct sealing and furnace replacement are completed before other retrofits are installed 
and that general air sealing is always completed after all other retrofits have been 
installed. The duct-sealing and furnace replacement retrofits, if applied, are then 
always listed first, regardless of how their SIR values compare to the SIR value of the 
next retrofit listed. The same is true for general air sealing except this retrofit, if 
applied, is always listed last. Because of this ordering, there could be some cases 
where the duct sealing and furnace replacement retrofits have SIR values less than 
those of the next retrofit measure listed, and the general air sealing retrofit could have 
a SIR value larger than the previous retrofit measure listed. 

3.5.2.1 Savings 

The cumulative annual energy and cost savings of the recommended retrofit measures 
for the manufactured home being evaluated are shown on the "Annual Savings" 
results screen (see Figure 3-42). Cumulative reporting of the results means that the 
effects of all retrofit measures listed up to the measure you are interested in are 
considered. For example, the energy and cost savings for the second measure on the 
list are calculated assuming the first measure has been installed. The results reported 
for the third measure on the list assume that the first and second measures are also 
both installed, and so on. 
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Weather Site: Denver. CO 
Rudit Date: 7/1/1997 

Job M e r :  123456789 
auditor: JRW 

Cumulative annual Savins 

conmended Heating Cooling 

1.4 36 1.4 36 
Y Cellulose Loose 23.1 579 23.1 579 

24.1 683 tic Storm Windows 24.1 603 
1 Fiberglass Bat+ 33.1 827 -41 -4 32.9 824 
Fiberglass Loose 36.2 986 -41 -4 36.1 982 

General Rir Sealins 45.8 1147 -41 -4 45.7 1143 

annual Consumption 
Heating <MMBtu> Cooling <kwh> 

Figure 3-42 The "Annual Savings" Screen 
Savings for each measure are given near the end of the "Annual Savings" screen. 
Sum the savings for a particular measure with the savings of previous measures and 
you will have calculated the cumulative savings value for that particular measure 
listed earlier on the Annual Savings screen. For example, to find the cumulative 
savings for the second measure, sum the savings for the first and second measures. 
To find the cumulative savings for the third measure, sum the savings for the first, 
second and third measures, and so on. 
Finally, a message at the end of the "Annual Savings" screen indicates if, according to 
MHEA calculations, the heating load is larger than the capacity of the manufactured 
home furnace. Months in which the heating equipment cannot meet the load are 
reported by number, where 1 = January, 2 = February, and so on. During the months 
the heating equipment cannot meet the heating load, the heating equipment is 
operating essentially continuously throughout the month. If no month numbers are 
given, then the heating equipment capacity is either equal to or greater than the 
heating load. 

3.5.2.2 SIR 

SlRs for the recommended retrofit measures are shown on this results screen (see 
Figure 3-43). The recommended measure's individual annual savings, installation 
costs, and SIR values are given as well as the cumulative values of these results. You 
will notice that the cumulative annual savings column is identical to the Total $ 
column on the "Savings" screen (see Section 3.5.2.1, Savings). The retrofit measure 
individual costs are the sum of the material, labor, and other costs for the particular 
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measure. You may view the costs breakdown on the "Costs" results screen (See 
Section 3.5.2.3). You may adjust retrofit measure costs by revising the information 
on the "Measure Cost" setup screen (see Section 4.1, Update Measure Costs). 
Cumulative reporting of the results means that the effects of all retrofit measures 
listed up to the measure you are interested in are considered. For example, the energy 
savings, costs, and'SIR values for the second measure on the list are calculated 
assuming the first measure has been installed. The results reported for the third 
measure on the list assume that the first and second measures are also both installed, 
and so on. 

C l i e n t  Nane: Doe, Jane 
R d d r e s s :  1 Mobile Hone h y  

Mobile Hone, S t a t e  12345 
Heather S i t e :  Denver, CO 

R u d i t  D a t e :  7/1/1997 

Job N u n b e r :  123456189 
audi tor :  JRU 

.............................................. 
W e a s u r e  ...................... 

Recowmended Savings Costs  SIR 
nea%ues <S/year> <S> 

------------- < O t h e r  Costs  Not Included i n  SIR Calcu la t ions  >------- 
Seal Ducts 36 96 1.6 36 96 1.6 

Bel ly  C e l l u l o s e  Loose 543 a 218 35.2 579 386 24.7 
P l a s t i c  S t o r n  Uindous 24 18 16.3 683 324 24.2 

W a l l  F i b e r g l a s s  Bat t  221 387 7 .1  824 711 14.9 
Roof F i b e r g l a s s  Loose 79 234 3.8 982 946 12.2 

General R i r  S e a l i n g  241 55 60.2 1143 1- 14.8 
MHHW ~1 .38 .  5/91 ----- .............................................. 

Figure 3-43 The "Savings-to-Investment Ratios,, Screen 

3.5.2.3 Costs 

The material quantity, cost breakdown, and cumulative costs for each of the 
recommended retrofit measures are shown on this results screen (see Fiame 3-44). 
Material quantity unit abbreviations are explained in Table 3.1. Costs for each 
measure are divided between material costs, labor costs to install the measure, other 
costs associated with the measure (if you indicated on the "General Information" 
input screen to include these costs), and the sum of these three categories. The 
cumulative total costs'are also displayed. 
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Table 3-1 Abbreviations Found on the Costs Results Screen 
Abbreviation Definition 

s uarefeet 
b .  baos of insulation 
ui. united inch (window measurement 

NOTE A united inch (ui.) is the method used by MHEA for measuring the size of 
a window. It is equivalent to the length plus the width of the window. If 
the size of a window is 24"x36", it's equivalent dimension will be 60 ui. 

l i e n t  Name: Doe. Jane 
A d i & - e s s :  1 Mobile Hone Uay 

Uobile Home. State  12345 
ather S i t e :  Denver. CO 
butiit Date: 7/1/1997 

buditor: JEtw 
b Number: 123456789 

Costs 

Quantity <S/neasure> 

64 100 210 

Fiberglass Loose 10 bg 34 100 1C30 234 
nerd1 A i r  Seal ing 1 ea 30 .......................................... 

Figure 3-44 The "Cost Breakdown" Screen 
Cumulative reporting of the results means that the effects of all retrofit measures 
listed up to the measure you are interested in are considered. For example, the total 
costs for the second measure on the list are calculated assuming the first measure has 
been installed. The results reported for the third measure on the list assume that the 
first and second measures are also both installed, and so on. 
Material, labor, and other costs for each measure may be adjusted by accessing the 
"Measure Costs" submenu found within the Setup main menu item (see Section 4.1, 
Update Measure Costs). 
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3.5.2.4, Billing 

The billing information you entered on the “Billing Input” screen (billing period, 
actual consumption, and degree-days) and MHEA predicted monthly energy 
consumption and degree-days are displayed on the “Billing Comparison” results 
screen (see Fiawe 3-45). For your information, the percent difference between the 
actual and the predicted total consumption is also shown. 

NOTE If you adjust the billing data after MHEA has completed its calculations 
using a previous set of billing data, you must rerun the calculations to 
include the adjusted billing data. 

Figure 3-45 The “Billing Comparison” Screen 

3.5.2.5 Sizing 

MHEA provides an estimate of the output 6f the heating equipment size that will 
meet heating requirements for the home described by the audit data (see Figure 3-46). 
Sizing calculations are based on the method outlined by “Manual J: Load Calculation 
for Residential Winter and Summer Air Conditioning,” (Seventh Addition, 1986) 
published by and used with the permission of the Air Conditioning Contractors of 
America. 
Manual J heating load calculations use a simple temperature difference approach for 
conduction, natural infitration, and duct heat losses. The indoor temperature is 
assumed to be 70” F and the outdoor design temperature varies with location. 
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Conduction heat loss is the sum of themal conductance of all components of the 
home’s envelope multiplied by the design temperature difference. Witration and 
duct heat loss are the product of each respective estimated air exchange rate and the 
design temperature difference. 
MHEA differs from the standard Manual J calculations in the following ways: (1) the 
thermal resistance of various building components is taken from specific construction 
details in the audit rather than from generalized tables published in Manual J; (2) 
calculations are done on the home as a whole, rather than room-by-room; and (3) duct 
losses ‘are based on a factor determined for the home as a whole, rather than by zone. 
Duct losses, when ducts are present, are based on Manual J Table 7A for insulated or 
uninsulated ducts in unheated spaces with supply air temperatures up to 120” F. 

Client Nane: lMEA Rudit Sample 
Rddress: 123 hgstref2t 

Rnytaun. USA 12345 

4 Lseather Site: Chicago, IL 
Audit Date: 88/29/1997 

Job PIrabet: 12345 
Auditor: R.E. Duce 

The sizing report summarizes the estimated heat loss contribution of various building 
components before and after weatherization. The design temperature and duct loss 
factors used in the calculations are reported in the notes which follow the summary 
table. 

Figure 346 The “Sizing Comparison” Screen 

Wall 
Floor 
Roof  
Windows 
Doors 

18413 
8888 

18479 
6682 
314 

6242 
5969 
3628 
3341 
279 

3.5.3 Comments 
The Comments submenu found within the View main menu item displays text you 
have entered on the “Comments” screen accessed from within the Inputs main menu. 
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The Comments screen is viewed by selecting the "Comments" option within the View 
main menu. You cannot edit comments while displaying the Comments screen from 
within the View main menu. To revise the text shown on this screen, open the 
Comments screen from within the Inputs menu (see Section 3.2.6, Comments ). 
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4.0 Customizing MHEA Parameters Using 
the Setup Menu 

In th is  chapter, you will learn how to review and adjust data used for the program 
calculations by selecting submenus under the Setup main menu item. Cost information, 
program default values, candidate weatherization retrofit measures, and weather information 
are all parameters you may customize in MHEA. You may revise these parameters either for 
a particular project file or for all project files you evaluate. 
If you decide to change Setup screen values for all project files, enter the updated 
information on the appropriate screens and select the Reset Default Data button located in 
the lower left comer of the Setup screens. After selecting this button, all the values you 
revised will be automatically applied to all future project files you evaluate. The default 
information will not change until you readjust the values and again select the Reset Default 
Data button. 
You. may revise Setup screen values for a particular project and not for all project files 
evaluated in the future. Update information on the appropriate screen and select the screen 
Okay button. The changes you have made to the Setup screen will be remembered by the 
program for the particular project file that you have open when the setup screen changes are 
made. You do not need to revise the setup screens every time you want to reevaluate that 
project file. The revisions will also not affect other project files you are evaluating. This 
feature is especially useful if, for example, there is an extra one-time cost associated with a 
particular retrofit measure that should not be included when that retrofit measure is evaluated 
in other project files. 

4.1 Update Measure Costs 
The "Retrofit Measure Cost Data" screens contain .cost information for all retrofit 
measures evaluated by MHEA (see Figure 4-1). You may revise the estimated life of 
the measure and the material, labor, and extra costs for each measure. Use any of the 
methods described in Section 1.3, Navigating Through MHEA, to edit the "Measure 
Cost" screen. 

NOTE You may permanently change the default values on the Setup screens by 
selecting the Reset Default Data button located in the lower left comer 
of all Setup screens. After selecting th is button, MHEA will use the 
revised default data when evaluating all future project files until you 
change it again. If you wish to change the default data for one project file 
only, select the Okay button (located in the lower right comer of the 
Setup screens). The revisions you have made will be stored with the 
project file you had open when the setup screen changes were made. You 
do not need to change the Setup information every time you want to 
evaluate that particular project file. 
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Figure 4-1 The "Retrofit Measure Cost Data,, Screen 
There are more retrofit measures than can be displayed on one screen. The retrofit 
measures have been divided into groups, and each group is displayed on separate 
screens. In the top left comer of each screen is a message that shows which screen 
out of the total number of "Cost Data" screens you are viewing. For example, if you 
are viewing the first screen that appears when you select the Measure Costs submenu, 
the message will say, "Screen 1 of 4." You may move through the screens by using 
the View buttons located in the top right comer of the "Cost Data" screens. 
View Buttons 

You may view other "Cost Data" screens by selecting View buttons. Changes 
may be made to "Cost Data" screens you have accessed using the View buttons. 

Select the Next button to move through the screens in ascending order. For 
example, if screen 1 of 4 is displayed and you click onto the Next  button, 
screen 2 of 4 will appear. 

Previous 
Select the Previous button to move through the screens in descending order. 
For example, if screen 2 of 3 is displayed and you click onto the Previous 
button, screen 1 of 3 will appear. 
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Retrofit Description 
The Retrofit Descriptions, listed in the left column of the "Cost Data" screens, are 
short phases describing each measure that MHEA can evaluate. You cannot alter 
this text. 

Life 
This is the expected length of time a measure is effective before wear, weather, or 
other damage usually occurs and the measure should be replaced. These values 
are listed in the second column of the "Cost Data" screens. Because MHEA 
calculates savings-to-investment ratios over a 20-year period, you cannot enter 
values for measure life of more than 20 years or less than 0 years. Enter the value 
as a whole number of years. For example, if a retrofit measure has an expected 
life of 5-112 years, enter either 5 or 6 years. 

Units 

The unit of measurement for each measure is listed in the Units column. You 
cannot revise these abbreviations. Abbreviations used on the "Cost Data" screens 
are given in Table 4- 1. 

Table 4-1 Abbreviations Found in the Cost Data Setup Screen 
Abbreviation I Definition 
ea. I each 
sf. I squarefeet 
ui. I united inch (window measurement) 

NOTE A united inch (ui.) is the method used by MHEA for measuring the size of 
a window. It is equivalent to the length plus the width of the window. If 
the size of a window is 24"x36", it's equivalent dimension will be 60 ui. 

NOTE Loose insulation costs are to be entered on a per square foot basis where 
the square footage refers to the gross area of the wall, roof, or belly. For 
example, if wall insulation is to be added to an 8 ft. x 60 ft. wall (total wall 
area is 480 ft2) and if the material cost is $50, then the cost per square foot 
is $0.104/ft2. ME€EA assumes 24-pound bags of insulation where the bag 
volume is 7.5 f?/bag for cellulose and 15 @/bag for fiberglass. Because 
the costs are entered on a per square foot basis, MHEA converts the 
calculated bags of insulation to an equivalent square feet number assuming 
an insulatable cavity depth of 3, 9, and 8 inches for wall, belly, and roof, 
respectively. 

Material Cost 
This column contains estimated costs to purchase the materials for a retrofit 
measure. To revise this information, enter the new cost in dollars and cents per 
unit measurement. For example, if a retrofit has a unit measurement of square 
feet, the cost entered should be equivalent to $XX.XX/sq. ft. 
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Labor Cost 
The cost of labor to install the retrofit measure is shown in the Labor Cost 
column. To revise this information, enter the new cost in dollars and cents per 
unit measurement. For example, if a retrofit has a unit measurement of square 
feet, the cost entered should be equivalent to $XX.xx/sq. ft. 

Extra Cost 
The far right column on the "Cost Data" screen contains extra costs for each 
measure. Extra costs are those other than material and labor costs that are 
associated with a particular retrofit measure. These costs may' include setup or 
repair costs necessary for the retrofit measure installation (for example, the cost of 
operating the equipment to blow loose insulation into the floor, wall, or roof 
sections of the manufactured home). Note that the costs should be entered in 
dollars and cents per measure. Added costs will be applied only to the 
corresponding retrofit measure during MHEA calculations. 

4.2 Revise Fuel Costs 
Adjust the fuel costs assumed by MHEA by selecting the Fuel Cost submenu option 
found within the Setup menu (see Section 1.3, Navigating Through lMHEA and see 
Fiawe 4-2). The fuel costs that are initially stored with MHEA are national average 
values. You may wish to update these costs to reflect local fuel prices. 

Figure 4-2 The "Fuel Costs" Screen 
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Enter the fuel prices in dollars per unit of fuel. For example, enter a cost for natural 
gas in $/1,000 cubic feet. 

NOTE Natural gas quantities are typically reported as per 1,000 cubic feet or as 
therms. These are equivalent units of measurement. 1,000 cubic feet = 1 
therm. 

NOTE You may permanently change the default values on the Setup screens by 
selecting the Reset Default Data button located in the lower left comer 
of all Setup screens. After selecting this button, MHEA will use the 
revised default data when evaluating all future project files until you 
change it again. If you wish to change the default data for one project file 
only, select the Okay button (located in the lower right comer of the 
Setup screens). The revisions you have made will be stored with the 
project file you have open when the setup screen changes were made. 
You do not need to change the Setup information every time you want to 
evaluate that particular project file. 

4.3 Adjust Fuel Escalation Rates 

The fuel escalation rates as determined by the U.S. Department of Energy are 
displayed on this screen (see Figure 4-3). DOE issues new fuel escalation rate values 
annually. 

I k 

See Figure 4-3 The "Fuel Escalation Rates" Screen 
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NOTE You may permanently change the default values on the Setup screens by 
selecting the Reset Default Data button located in the lower left comer 
of all Setup screens. After selecting this button, MHEA will use the 
revised default data when evaluating all future project fdes until you 
change it again. If you wish to change the default data for one project fde 
only, select the Okay button (located in the lower right comer of the 
Setup screens). The revisions you have made will be stored with the 
project file you had open when the setup screen changes were made. You 
do not need to change the Setup information every time you want to 
evaluate that particular project file. 

Select a Fuel Tvue 
Press the Select Fuel Type button to list the heating fuel types that can be 
evaluated by MHEA (see Figure 4-4). Select a fuel type by highlighting the 
desired fuel using either your mouse or keyboard (see Section 1.3, Navigating 
Through MHEA). When you leave the selection list (by pressing the Okay button 
located at the bottom of the Select the Fuel Type box), MHEA will return to the 
"Fuel Escalation Rates" screen with the fuel you have selected listed as the 
Current Fuel Type. 

Figure 4-4 The "Select the Fuel Type" Screen 
Enter the escalation rates for all 25 years for the fuel type you have selected. 
Year 0 is the current year. Year 1 is the next year. Year 2 is two years from the 
current year and so on. For example, if the current year is 1997, year 1 is 1998, 
year 2 is 1999, and so on. 
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4.4 Select Candidate Measures 
Choose the retrofit measures to be included with MHEA calculations by placing a 
check mark by those measures to be evaluated (see Figure 4-5). Remove the check 
mark from a checked box or add a check mark to an empty box by highlighting the 
appropriate check box and pressing the left mouse key or enter. You may also use the 
CTRuletter or ALT /letter key method (see Section 1.3, Navigating Through 
MHEA). All checked measures are considered during MHFiA calculations. 
The retrofit measures listed on the "Candidate Measures" screen are described in 
more detail in Appendix B, Retrofit Measures. 

Figure 4-5 The "Candidate Measures" Screen 

NOTE You may permanently change the default values on the Setup screens by 
selecting the Reset Default Data  button located in the lower left comer 
of all Setup screens. After selecting this button, MHEA will use the 
revised default data when evaluating all future project files until you 
change it again. If you wish to change the default data for one project file 
only, select the Okay button (located in the lower right comer of the 
Setup screens). The revisions you have made will be stored with the 
project file you had open when the setup screen changes were made. You 
do not need to change the Setup information every time you want to 
evaluate that particular project file. 
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Change MHEA Defaults 
Adjust MHEA default values to more accurately reflect characteristics of the housing 
stock you are evaluating. Select the Default Values submenu to make changes either 
to the input screen defaults or to the values used during MHEA calculations see 
Section 1.3, Navigating Through MHEA. 

NOTE You may permanently change the default values on the Setup screens by 
selecting the Reset Default Data button located in the lower left comer 
of all Setup screens. After selecting this button, MHEA will use the 
revised default data when evaluating all future project files until you 
change it again. If you wish to change the default data for one project file 
only, select the Okay button (located in the lower right comer of the 
Setup screens). The revisions you have made will be stored with the 
project file you had open when the setup screen changes were made. You 
do not need to change the Setup information every time you want to 
evaluate that particular project file. 

4.5.1 Input Screen Defaults 

Adjust default values appearing on the Inputs screens by selecting the Inputs option 
from the second submenu list that appears when you select the Default Values 
submenu (see Figure 4-6). Choose the input screen you wish to alter (see Figure 4-7). 
On all input screens, you may adjust all but one set of input defaults. Make the 
appropriate changes by placing check marks and entering new information in the 
editable fields. When you are satisfied with the new defaults, select the Reset 
Default Data button located in the lower right comer of each input screen. 

c 
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Previous 
Select the Previous button to move through the screens in descending order. 
For example, if screen 2 of 10 is displayed and you click onto the Previous 
button, screen 1 of 10 will appear. 

Figure 4-9 The "Default Parameters" Screen 
Parameter Description 

Text that describes default calculation parameters used by MHEA is listed in the 
left column of the "Default Parameters" screens. You cannot alter this text. 

Parameter Units 
The units for the default calculation parameters are listed in the second column on 
the "Default Parameters" screens. You cannot alter this text. 

Value 
The default value for each parameter is listed in the far right column on the 
"Default Parameters" screens. These are the values you adjust to more accurately 
reflect the housing stock you are evaluating. 

Real Discount Rate 
The real discount rate adjusts the economic calculations for inflation. DOE 
annually determines the discount rate to be used. An unaltered rate may be used 
for weatherization economic evaluations for up to 5 years. A higher rate than that 
determined by DOE may be used if the adjusted rate is within the range of 3% to 
10%. For more information, refer to section 440.21 (i) of the DOE rule, titled 
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"WeatheIization Assistance Program for Low-Income Persons" approved in 
March 1993. 

Minimum Acceptable SIR 
Enter the minimum acceptable SIR value to be used during MHEA economic 
evaluation. The minimum acceptable SIR value for retrofit measures interactive 
effect is 1 according to the DOE rule, "Weatherization Assistance Program for 
Low-Income Persons" approved in March 1993. 

Free Heat from Interior Sources-Dav, Night 
Free heat is the heat resulting from activities taking place within the home. 
MHEA initially assumes a daytime free heat daytime load of 2,400 Btuh from 
occupant activities that include cooking, hot water use, appliance use, and 
lighting. The MHEA assumed free heat nighttime heat load is 1,000 Btuh for 
occupants at rest, miscellaneous appliances that operate continuously (electric 
clocks, etc.) and lighting. 

L e n ~  of Day for Thermostat Setback 
MHEA assumes that if an automatic setback thermostat is in use, the length of a 
day is 16 hours. If the occupants adjust the nighttime thermostat setting for 
something other than 8 hours, adjust the length of day value used in the setback 
thermostat calculations. 

Thermostat Setback Amount 
MHEA assumes an automatic setback thermostat adjusts the indoor temperature 
by +/- 5' F. For example, during the heating season, MHEA assumes the 
nighttime indoor temperature will be 5' F lower at night than during the day. This 
5' F assumption is adjusted by revising the Thermostat Setback Amount default 
parameter. 

Duct-Sealing. Duct Insulation Distribution Loss Reduction 
The duct distribution loss is the supply air lost to the outside through holes in the 
duct that does not reenter the living space. The percent reduction in the duct 
distribution loss because of duct sealing or insulating around the ducts is the Duct 
Sealing, Duct Insulation Distribution Loss Reduction. Insulating around the ducts 
usually is a result of filling the belly or roof cavity with loose insulation. 

Batt/Bfanket, Loose, Rigid, Foamcore Insulation R-value Per Inch 
Enter the R-value per inch for the insulation to be used in MHEA energy 
calculations. This value is used to evaluate the insulating effect of existing 
insulation described on the input screens as well as the insulating effect of new 
insulation added during weatherization. Note that rigid insulation is typically 
found in the roof section and that foamcore insulation is typically found in the 
wall sections of the manufactured home. 
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Door U-Value-Wood with Solid Core, Wood with Hollow Core, Standard 
Manufactured Home Door 

Enter the U-value for the door. This value is used to evaluate the insulating effect 
of the existing doors described on the input screens. If the existing doors do not 
fit this or the other door descriptions, enter the appropriate U-value for the door 
type chosen to represent the existing manufactured home door and note the 
difference on the "Comment" screen (see Section 3.2.6, Comments). Note that 
MHEA assumes a standard manufactured home door has a solid core and a vinyl 
or fiberglass skin. 

U-value of Replacement Door 
Enter the U-value for a replacement manufactured home door. This value is used 
to evaluate the insulating effect of the replacement doors. 

Interior Ceiling R-value: Summer, Winter 
Enter the R-value of the interior ceiling components for the summer and winter 
seasons. The ceiling components may simply include the ceiling material and the 
surface resistance of the air. Refer to literature related to approximating R-values 
of building components for further detail. 

Interior Floor R-value: Summer- Winter 
Enter the R-value of the interior floor components for the summer and winter 
seasons. The floor components may simply include the flooring material, floor 
covering, and the surface resistance of the air. Refer to literature related to 
approximating R-values of building components for further detail. 

Interior Wall R-value: Summer, Winter 
Enter the R-value of the interior wall components for the summer and winter 
seasons. The wall components may simply include the interior wall material and 
the surface resistance of the air. Refer to literature related to approximating 
R-values of building components for further detail. 

Outside Wall R-value: Summer, Winter 
Enter the R-value of the outside wall components for the summer and winter 
seasons. The wall components may simply include the exterior wall material and 
the surface resistance of the air. Refer to literature related to approximating 
R-values of building components for further detail. 

Window U-value: Summer:, Winter 
Enter the U-value of the windows with no storm windows for the summer and 
winter seasons. Refer to manufacturer's literature or literature related to 
approximating window U-values for further detail. 

Window U-value with Glass Storm: Summer. Winter 
Enter the U-value of the windows with a glass storm for the summer and winter 
seasons. Refer to manufacturer's literature or literature related to approximating 
window U-values for further detail. 
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Window U-value with Plastic Storm: Summer, Winter 
Enter the U-value of the windows with a plastic storm for the summer and winter 
season. Refer to manufacturer's literature or literature related to approximating 
window U-values for further detail. 

Skylight U-value: Summer, Winter 
Enter the U-value of the skylights with no storms for the summer and winter 
seasons. Refer to manufacturer's literature or literature related to approximating 
skylight U-values for further detail. 

Skylight U-value with Glass Storm: Summer. Winter 
Enter the U-value of the skylights with a glass storm for the summer and winter 
seasons. Refer to manufacturer's literature or literature related to approximating 
skylight U-values for further detail. 

Skvlight U-value with Plastic Storm: Summer. Winter 
Enter the U-value of'the skylights with a plastic storm for the summer and winter 
seasons. Refer to manufacturer's literature or literature related to approximating 
skylight U-values for further detail. 

Window Shadin? R-value. Blinds or Shades, Drapes, Drapes and Shades 
Enter the R-value of the interior window covering. Refer to manufacturer's 
literature or literature related to approximating R-values of interior window 
shading devices for further detail. 

Ratio of Awning Depth to Window Height 
Enter the ratio of the exterior window awning depth to the height of the window 
(depthheight). The depth of the awning is the distance the awning extends from 
the exterior of the manufactured home. This value is used to calculate the shading 
effect of the awning on the window. 

Sun Screen Solar Transmittance Reduction: Summer, Winter 
Enter the percent reduction of solar transmittance in the summer and winter due to 
an exterior window sun screen. The solar transmittance is the fraction of solar 
energy that travels through the window into the living space of the manufactured 
home. Refer to manufacturer's literature or literature related to sun screen solar 
transmittance for further detail. 

HeatinB Efficiency: Natural Gas. Electric, Heat Pump, Propane, Oil, Kerosene. Coal, 
Wood 

Enter the heating efficiency of the heating equipment. The heating efficiency is 
the fraction of heat supplied to the living space by the equipment after fuel is 
consumed to produce the heat. The efficiency entered should be for the heating 
equipment only and not take into account the air supply system. 

118 Manufactured home Energy Audit 



NOTE the electric furnace is 100% efficient as long as it is located in the living 
space of the manufactured home. If the electric furnace is located in a 

. closet with an exterior access, the heating efficiency should be derated. 

NOTE The heating efficiency of a heat pump is analogous to the heating 
coefficient of performance (COP). For example, if the heating COP is 2, 
the efficiency is 200%. The COP can be calculated from the heat pump 
seasonal performance factor (HSPF) by dividing the HSPF value by 3.413. 

Tune-up Heating Efficiency: Natural Gas, Oil. Prouane. Kerosene. Coal. Wood 
Enter the heating efficiency of the heating equipment after a system tune-up. The 
heating efficiency is the fraction of heat supplied to the living space by the 
equipment after fuel is consumed to produce the heat. The efficiency entered 
should be for the heating equipment only and not take into account the air supply 
system. 

Reulacement Heating Efficiency: Natural Gas. Oil. Prouane. Kerosene 
Enter the heating efficiency of the replacement heating equipment. The heating 
efficiency is the fraction of heat supplied to the living space by the equipment 
after fuel is consumed to produce the heat. The efficiency entered should be for 
the heating equipment only and not take into account the air supply system. 

Cooling Svstem Fan Power 
Enter the fan power of the cooling system fan. 
equipment cooling capacity and equipment energy consumption calculations. 

This value is used in the 

Evauorative Cooler Actual Saturating Efficiency 
Enter the actual saturating efficiency of the evaporative cooler. Refer to 
manufacturer's literature or literature describing' evaporative cooler operation for 
actual saturating efficiency values. 

Saturating Efficiency for Evauorative Tune-up 
Enter the saturating efficiency after a tune-up has been performed on an 
evaporative cooler. 

Saturating Efficiency for Evauorative Reulacement 
Enter the saturating efficiency of a replacement evaporative cooler. The 
manufacturer's literature should help indicate the new evaporative cooler 
saturating efficiency. 

Home Leakiness Parameter: Tight. Medium, Loose 
Enter the infiltration value assumed by MHEA for a manufactured home of tight, 
medium, and loose construction. This value will be used to evaluate the home 
energy consumption and the benefits of infiltration reduction measures. The 
home leakiness is indicated on the "General Information Input" screen (see 
section 3.2.1, General Information). 
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Target Post-Retrofit Home Infiltration 
Enter infiltration rate to which you plan to bring the manufactured home after 
installing a package of retrofit measures. MHEA will use this value when 
calculating the effectiveness of the general air-sealing retrofit measure. 

Spending Limit for Package of Measures 
Enter the maximum amount of money, in dollars, to be spent on a package of 
measures to retrofit the home. If the costs exceed this value a message will 
appear in theTosts" screen found in the Results menu. 

4.6 InstalVRemove Weather Data 
You must install weather data onto your computer in order to run MHEA. If you 
choose a city (see Section 4.7, Choose a City) that has not been installed and try to 
run MHEA you will be asked to install that city's weather data. 
Install Weather Data 

Select the Install Weather Data submenu from the Setup menu. MHEA will then 
ask you to insert the MHEA disk into the floppy disk drive. Press Okay if the 
disk is in the drive or press Cancel if it is not. After inserting the MHEA disk 
into drive A: and selecting the Okay button the software will again ask you if the 
disk has been inserted into the floppy disk drive. If it has, select the Okay button 
again and the "Check Weather Files to Install" screen (see Figure 4-10) will then 
appear. Use the left mouse button to click on the cities that you would like to 
install. A check mark will appear next to those cities. Press the Okay button if 
cities that you wish to install have check marks next to them. Press the Cancel 
button if you don not wish to install any weather files. 

NOTE The Chicago, Illinois, weather file (chicagil,wx) is installed as the default 
weather file when you install the software (see Section 1.2). 

WARNING You can only install weather files from a disk located in your A: 
drive. If you do not have a disk for your A drive, copy the files 
weather-exe and weather-1st onto a disk that is properly formatted for 
your A: drive or contact the DOE Weatherization Assistance 
Program. 

Remove Weather Data 
Select the Remove Weather Data submenu from the Setup menu. The "Check 
Files to Erase" screen will appear. Use the left mouse button to click on the cities 
that you would like to remove. A check mark will appear next to those cities. 
Press the Okay button if cities that you wish to remove have check marks next to 
them. Press the Cancel button if you don not wish to remove any weather files. 
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4.7 Choose a City 
Select the Choose Weather File submenu to choose a city for which weather data will 
be used during MHEA calculations (see Figure 4-11). Use any of the methods 
described in Section 1.3, Navigating Through MHEA, to select the submenu item and 
then to choose a city. 

Figure 4- 1 1 The ‘Weather Data Site” Screen 
Select a State 

Press the Select a State button to access a list of states (see Fiapre 4-12). Scroll 
through the list (see Section 1.5.5, Scroll Bars) until the state you wish to select is 
listed on the screen. Highlight the state with your mouse or from the keyboard 
and press either the left mouse button or the ENTER key. The state you have 
selected will appear in the bar at the top of the state list. Accept this state by 
selecting the Okay button on the “Select a State” screen. The state you have 
selected will now appear in as the current state on the “Weather Data Site” screen. 

Select a City 
Press the Select a City button to access a list of cities in the state you previously 
selected. Scroll through the list (see Section 1.5.5, Scroll Bars) until the city you 
wish to select is listed on the screen. Highlight the city with your mouse or from 
the keyboard and press either the left mouse button or the ENTER key. The city 
you have selected will appear in the bar at the top of the city list. Accept this city 
by selecting the Okay button on the “Select the City” screen. The city you have 
selected will now appear as the current city on the Weather Data Site screen. 
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Figure 4-12 The “Select the State” Screen 

NOTE You may permanently change the default values on the Setup screens by 
selecting the Rese t  Default Data button located in the lower left comer 
of all Setup screens. After selecting this button, MHEA will use the 
revised default data when evaluating all future project fdes until you 
change it again. If you wish to change the default data for one project file 
only, select the Okay button (located in the lower right comer of the 
Setup screens). The revisions you have made will be stored with the 
project file you had open when the setup screen changes were made. You 
do not need to change the Setup information every time you want to 
evaluate that particular project file. 

NOTE MHEA assigns Chicago, Illinois, as the default city when you initially 
install MHEA. If you select a different city in one project file, and then 
open a new audit, Chicago will be restored as the default city, unless you 
press the Rese t  Default Data button. 

NOTE You must install the weather data you wish to use. All the cities that are 
available in the weather data files are listed when you view the city 
selection. The information for these cities is not on your computer unless 
you install this data (see Section 4.6, InstalVRemove Weather Data). 
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Appendix A 
Glossary 

Addition - Manufactured home additions are add-on structures conditioned by the 
home heating and cooling systems. Additions cannot be separated from the 
manufactui-ed home (for example, by closing the door to an entrance vestibule). 
Additions that are part of the living space must be included in the energy calculations 
of the home. If the addition is usually separated from the manufactured home, it 
should not be included when evaluating weatherization retrofit measures for the 
home. 
ARROW .Keys - ARROW keys are keys on your computer keyboard that move the 
cursor in the direction of the mow printed on the key. 
Base Load - The base load is the energy required to operate the domestic hot water 
heater, lights, cooking, clothes washing, and other homehold appliances that are used 
throughout the year. For example, if the heating equipment uses natural gas, the base 
electricity load can be estimated by averaging the monthly electricity consumption 
during the winter months. 
Button - Buttons appear on al l  MHEA screens. Buttons are gray boxes surrounded 
by a boarder so that they appear as though they are slightly taller than the computer 
screen. When a button is selected, the border changes so that it seems as though the 
button has been pushed into the screen. All MHEA screens have an Okay button, 
used to accept the conditions on the screen and continue working in other parts of 
MHEA. Several other buttons that appear on MHEA screens include the Cancel, 
Defaults, Reset Defaults, and buttons specific to an individual screen. 
Check Mark - Many MHEA input and setup screens have lists of options. An 
option is selected by placing a check mark in the box or column next to the 
appropriate option. Place a check mark by using the mouse or any of the keyboard 
methods described in Section 1.3, Navigating Through MHEA. 
Click - Click refers to pressing a mouse button (one of the two or three buttons at the 
top of an MS-DOSQ-compatible mouse). 
Cursor - The cursor is the black arrow that appears on all MHEA screens. Point the 
artow to the location where data is to be recorded (by placing a check mark or 
entering information into an editable field) or to select a button. Refer to Section 1.3, 
Navigating Through MHEA, to learn how to move the cursor using either the mouse 
or the keyboard. 
Editable Field - An editable field is a location on an MHEA input or setup screen 
where numbers, letters, or other characters can be typed. 
Energy Consumption - Energy consumption is the energy used by the occupants of 
a manufactured home. This energy is either electricity supplied by a utility or fuel 
that is burned in the home (ie., natural gas, wood, etc.). Occupants consume energy 
to heat and cool their homes, cook, heat water, power lights, and other uses. 
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ENTER Key - The ENTER key is located at the right end of the third row of keys of the 
letter pad on a computer keyboard. This key is pressed when using keyboard 
methods to place the cursor (see Section 1.3, Navigating Through MHEA). 
File - File is the main menu item listed first on the MHEA menu bar. Project files 
are managed from the submenu items available within the File menu. For more 
information about the File submenu options, refer to Section 3.1, Manage Project 
Files Using the File Menu. 
Floppy Disk Drive - The floppy disk drive is where you insert a diskette into your 
computer. You must have a floppy disk drive to install MHEA software. If a 
computer has only one floppy disk drive, it is usually identi.fied as the A drive. If the 
computer you are using has two floppy 'disk drives, be sure to note how the one you 
are using to install MHEA is identified (usually identified as the A drive or the B 
drive) before you begin the installation procedure (see Section 1.2, Installing 
MHEA). 
Graphic Display - The graphic display is the monitor attached to your computer. 
MHEA requires that you have a VGA monitor. 
Hard Disk Drive - The hard disk drive is where information is stored within your 
computer. MHEA is stored on the hard drive after you have installed it from a 
diskette. All project files are also stored on the hard drive. On most computers, the 
hard drive is identified as the C drive. Be sure to check how the hard drive on your 
computer is'identified before installing MHEA software. 
Help - Help is the main menu item listed last on the MHEA menu bar. The 
submenu options available from the Help menu include: Help Topics, all the help 
messages that are included with MHEA, Instructions, a brief summary of how to use 
MHEA; and About, a short description of MHEA and a quick energy use/square 
footheating degree-day calculation. In future versions of MHEA, a tutorial wilI be 
available to help new MHEA users become familiar with the software. See Chapter 
2.0, Using On-Line Help, for more information about the Help submenu options.. 
Inputs - Inputs is the main menu item listed second on the MHEA menu bar. All 
information describing the manufactured home construction, the heating and cooling 
equipment, and utility bill data, is entered on the screens that are available from the 
Inputs submenu options (see Section 3.2, Enter Input Data Using the Inputs Menu). 
Input Screens - Input screens are the MHEA displays where you enter information 
about the manufactured home construction, the heating and cooling equipment, and 
utility bill data (see Section 3.2, Center Input Data Using the Inputs&Menu). 
Memory - Memory refers to how information is stored in your computer. 
Menu Bar - Main menu headings are displayed in the menu bar. The menu bar is 
located at the top of the MHEA background screen. Refer to section 1.5.1, Menu 
Bar, for more information about the menu bar. 
Menu Item - Menu items are the main headings displayed in the menu bar. Select 
menu items to enter descriptive information about the manufactured home, run 
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MHEA calculations, view the calculation results, and adjust setup information. 
Refer to Chapters 3, Performing an Audit, and 4, Customizing MHEA Parameters 
Using the Setup Menu, for more information about what is available from within 
each menu item. 
MBEA - Manufactured Home Energy Audit. The name of the software tool 
designed to recommend weatherization retrofit measures for manufactured homes. 
MHEA evaluates energy use and analyzes the effect of installing weatherization 
retrofit measures in order to prioritize the most effective measures recommended for 
installation. 
Manufactured home - A manufactured home is constructed in a factory and has a 
permanent chassis as part of the frame so that it can be easily moved. Manufactured 
homes are constructed either as one unit (usually less than 20 feet wide) or as two 
long units (each unit is usually less than 20 feet wide) that are attached at the center 
after the two parts have been moved separately to the site the home will occupy. 
Monitor - A computer monitor is the device on which images are displayed. 
Mouse - A computer mouse is a device used to move a cursor around the screens that 
are displayed while using MHEA. A MS-DOSO-compatible mouse will have two or 
three keys located at the top of the mouse. Rest your hand on the large part of the 
mouse so that your middle fingers can access these keys. Move the mouse with your 
hand so that the cursor moves to the desired location on the screen. For more 
information on how to use the mouse, see Section 1.3.1, Using Your Mouse. 
Operating System - The operating system is the software on your hard drive that 
controls all executions that occur while you are using your computer. MHEA 
requires the operating system to be MS-DOS@, version 4.2 or later. 
Quit - Quit is the main menu item listed fifth on the MHEA menu bar. When you 
are ready to leave MHEA software and return to the operating system, select the 
Quit menu item and answer Okay to the question that immediately appears on the 
screen. 
Printer - The printer is the device to which MHEA sends information to be printed. 
MHEA can send information to most commonly used printer types. 
Project File - A project file is the location in the computer memory where 
information about a manufactured home is stored. The MHEA user names the 
project file when information about a home is entered for the first time. Both input 
data and calculation results are stored in this project file. 
Results - Results is the main menu item listed fourth on the MHEA menu bar. 
MHEA calculation results are displayed on the screens that appear when you select 
the Results submenu options. 
Run - Run is the third item listed on the MHEA main menu bar. Initiate MHEA 
calculation procedures by ielecting the appropriate Run submenu item. See Section 
3.4, Perform Energy Use and Cost Analysis, for more information about how to 
evaluate data in a MHEA project file. 
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Screen - An MHEA screen is the information displayed on your computer monitor 
when you select menu and submenu items. 
Scroll Bars - Scroll bars appear on screens that contain more information than can fit 
onto a screen the size of your computer monitor. Use the scroll bars to move the 
screen up and down. Refer to Section 1.5.5, Scroll Bars, for information about using 
the scroll bars. 
Select - To select an item on an MHEA screen means to place a check mark, access 
an editable field, or activate a button. To select an item, use any of the mouse or 
keyboard methods described in Section 1.3, Navigating Through MHEA. 
Setup - Setup is the main menu item listed seventh on the MHEA menu bar. 
Parameters needed to execute MHEA calculations can be adjusted by accessing the 
screens that appear when you select the Setup submenu items. Refer to Chapter 4, 
Customizing MHEA Parameters Using the Setup Menu, for more information about 
how to use the Setup submenu screens. 
SH~FT Key - The s m  key is located at the far left and right ends of the second row 
of the letter pad on your computer keyboard. You will need these keys if you use the 
keyboard while working through MHEA (see Section 1.3.2, Using your Keyboard). 
Status Bar - The status bar is located at the bottom of the MHEA background 
screen. Directions on how to access help messages and the name of the project file 
you are working in are displayed in the status bar (see Section 1.5.6, Status Bar). 
Submenu - Submenu items are the options that appear when you select main menu 
items. 
View - View is the fourth main menu item on the MHEA menu bar. Access the 
screens available from the View submenu items to display summaries of the project 
file inputs, calculation results, and comments entered on the comment screen. You 
cannot edit screens access through the View submenu. Return to the Input screens 
and rerun the calculations to revise the information shown on the View screens. 
VGA - VGA refers to the type of monitor you have attached to your computer hard 
drive. A VGA monitor is required to operate MHEA software. 
Weatherization Retrofit Measures - Weatherization retrofit measures are the 
changes made to a manufactured home to make it more energy efficient. MHEA 
evaluates weatherization retrofit measures based on the existing home construction 
conditions (described on the Input screens), the local weather conditions, and the cost 
of retrofit measures. Recommended retrofit measures are then listed according to 
their savings-to-investment ratios. Refer to Section 3.5.2, Results, and Appendix B, 
Retrofit Measure Descriptions, for more information about weatherization retrofit 
measures evaluated by M E A .  
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Appendix B 
Retrofit Measure Descriptions 

Descriptions of the retrofit measures that are evaluated by MHEA are summarized in 
this appendix. Recommended methods for installing retrofit measures are given in 
some cases. Each Weatherization agency will have its own methods for installing 
retrofit measures. Those methods outlined in this appendix are not necessarily the 
only or best methods for effective weatherization. 

Seal Ducts 
It is very common to find leaks in manufactured home supply air ducts. 
Leaks are typically found where the supply duct connects to the furnace, 
at the junction between the air delivery plenum and the vertical floor 
register sleeves, where the vertical duct sleeves penetrate the 
subfloor/ceiling, and at the end of the supply duct run. These leaks can be 
found using a flashlight and mirror aimed from a supply register. 
Another method for fmding leaks is to use a pressure pan and blower 
door. Leak locations can be isolated by successively sealing off sections 
of the duct with temporary air blocks while observing blower door 
readings. Openings can be sealed using silicone caulk or mastic. Large 
holes can be sealed with rigid foam or a combination of mastic, mesh 
tape, sheet-metal patches, and screws. 
Many manufactured homes return air to the furnace through a register in 
the furnace closet door. Some manufactured homes have return air either 
through ducts or through open plenums in the floor or ceiling. Typically, 
such systems are extremely leaky. Return air systems are also 
unnecessary because of the small volume of manufactured homes. 
MHEA calculations assume the return air registers in the floor and the 
return air chase at the furnace are sealed during the duct-sealing 
procedure. MHEA also assumes that a register is installed in the furnace 
closet door and a 1 to 1-112 inches clearance between the bottom of the 
bedroom and bathroom doors and the floor or carpet is added to 
accommodate return air flow to the furnace as part of this procedure. 
Duct leaks have a large effect on home energy consumption, both when 
the furnace fan is on and off. When the furnace fan is on, heated 
distribution air leaks out into the underfloor (roof) space and then to the 
outside environment, decreasing the overall efficiency of the heating 
distribution system furnace. When the fan is off, extra infiltration leakage 
paths exist from the underfloor (roof) area through the ducts and then 
through the air registers into the living space. 

General Air Sealing 
Manufactured homes, especially those constructed prior to the 1976 Housing 
and Urban Development manufactured home construction standards, are 
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inherently leaky. Leakage locations typically are: water heater closets with 
exterior access; furnace flue and combustion air duct penetrations through the 
rodent barrier, floor, and ceiling; evaporative cooler chase penetration 
through the ceiling; doors and windows that do not seal properly when 
closed; kitchen vent fans; and damaged rodent barriers. 
While sealing an exterior water heater closet, insulation should be installed 
wherever possible including the common wall, the outside wall, and the door 
of the closet. Note that the exterior door should be sealed as well. Redirect 
combustion air fiom the register in the exterior door to a combustion air duct 
installed in the floor of the closet that pulls air in from under the belly of the 
home. Sealing and insulating can be accomplished with l/&inch hardboard 
and silicone or, for the less accessible areas, 6-mil polyethylene sheet or 
insulating aluminized foil and construction adhesive. Large openings can be 
stuffed with batt insulation and sealed with an insulating foil membrane. 
Wrap water pipes to avoid freezing. BE SURE THERE IS ADEQUATE 
COMBUSTION AIR AVAILABLE FROM THE OUTSIDE IF THE 
WATER HEA'IER IS FUELED BY GAS OR OIL. 
Penetrations through the ceiling and floor from the furnace flue and those 
fiom combustion air ducts can be sealed using a silicone caulk. Covering the 
opening in the ceiling with an interior plastic cover may stop evaporative 
cooler chase leaks. Covers are commercially available or can be constructed 
in the same manner as interior plastic storms. This type of cover is simple to 
remove and store during the cooling months when the evaporative cooler is in 
use. Install a similar cover used for evaporative cooler chases over a room air 
conditioner (inside the home). Do not cover the portion of the room air 
conditioner that extends outdoors unless the inside portion is also covered. 
Also, check that the perimeter of the room air conditioner is sealed tightly. 
Inexpensive window repairs include installing ludwig clips to tightly close 
the panes of jalousie or awning-type windows, replacing the window- 
operating mechanisms, replacing the panes, repairing or replacing damaged 
seals at awning and jalousie pane edges with weather stripping, rerouting 
cables (such as TV or other cables) through the floor or walls (and seal new 
opening), and sealing cracks between the window trim and the interior wall 
with silicon acrylic caulk. 
Seal leaks around doors by replacing damaged, missing, or degraded weather 
stripping on door flanges. Repair or adjust latch plates if damaged. Damaged 
plates prevent tight sealing of the door. Replace the door if there is a 
damaged door flange. A damaged flange prevents a pressure fit of the 
weather stripping upon closure. Replace damaged window with rigid 
insulation sheathed in manufactured home siding. 
Ensure that the kitchen vent fans are operating properly and that they are 
sealed shut when the fan is turned off. 
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I A damaged rodent barrier allows outside air to enter the floor section. When 
this occurs, any insulation that may exist in the floor section essentially has 
no effect. All damage to the rodent barrier should be repaired before 
insulation is added to the belly. 
Wall Insulation-Batt Fiberdass 

Add 3-112 inches offiberglass ban insulation to walls. 

This retrofit measure is evaluated if the insulatable space in 
the walls is 1 inch or greater. A recommended method of 
stuffing batt insulation into the wall cavity is listed below. 

1) Ensure interior paneling is tightly fastened to the wall frame. 
2) Remove bottom two rows of screws from exterior siding and look 
inside the wall cavity to see where wiring is located. 
3) Cut vinyl-backed fiberglass batts or unfaced fiberglass insulation 
batts and flexible plastic sheeting approximately 8 inches longer than 
the len,@ of the cavity to be stuffed. 
4) Sandwich the insulation between the vinyl backing/plastic sheeting 
and a sheet metal insulation "stuffer", fold the insulation (and plastic 
sheeting) over the top of the stuffer, push the insulation up into the 
cavity with the vinyl backing/plastic sheeting facing the interior 
paneling. 
Note that the wiring location may be such that stuffing batt insulation 
is not possible (for example, if the wiring passes through the center of 
the wall studs). 

Wall Insulation-Loose Cellulose 
Fill walls with loose insulation. 

Caution: 
Use a f l l  tube that minimizes buildrcp of static elecfricity and 
discharge it frequently. 

This retrofit measure is evaluated if the insulatable space in the walls 
is 2 inches or greater. Adding loose insulation will increase the R- 
value of the walls. If the siding is metal, check that the interior 
paneling is secured, remove the bottom row of exterior siding screws, 
and use a flexible fill tube to fill each cavity between the interior 
paneling and the existing insulation starting at the top of the wall and 
working down. If the exterior siding is wood, then drill a hole in each 
cavity approximately 1 foot from the bottom of the wall and use a 
flexible-frll tube (8 feet long, 1 to 2 inches in diameter) to fill the 
cavity, starting at the top of the wall and working down. Be careful 
not to damage electrical boxes and wire located in the walls while 
filling the cavities with loose insulation. 
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Wall Insulation-Loose Fiberglass 
Fill walls with loose insulation. 

Caution: 
Use a fill tube that minimizes buildup of static electricity and 
discharge it f i e  pently. 

This retrofit measure is evaluated if the insulatable space in the walls is 2 
inches or greater. Adding loose insulation will increase the R-value of the 
walls. If the siding is metal, check that the interior paneling is secured, 
remove the bottom row of exterior siding screws, and use a flexible-fill 
tube to fill each cavity between the interior paneling and the existing 
insulation starting at the top of the wall and working down. If the exterior 
siding is wood, then drill a hole in each cavity approximately 1 foot from 
the bottom of the wall and use a flexible-fill tube (8 feet long, 1 to 2 
inches in diameter) to fill the cavity, starting at the top of the wall and 
working down. Be careful not to damage electrical boxes and wire 
located in the walls while fdling the cavities with loose insulation. 

' 

Bellv Insulation-Loose Cellulose 
Fill belly with loose insulation. 

Caution: 
Use a fill tube that minimizes buildup of static electricity and 
discharge it frequently. 

This retrofit measure is evaluated if the depth of the existing insulation in 
the belly section is less than the average belly depth. The benefit from 
filling the belly with loose insulation is threefold: 1) the R-value of the 
floor section is increased; 2) if the duct is located under the floor, the duct 
distribution loss is decreased (resulting in an increased furnace delivery 
efficiency); and 3) the floor of the manufactured home remains warm in 
the winter, increasing occupant comfort. Be sure to repair holes in the 
belly, repair openings in the floor, and seal the duct (if located under the 
floor) before blowing insulation into the belly section.  also, be careful 
that there is at least 2 inches of insulation under pipes located in the belly 
section and do not insulate above water pipes. Finally, insulate the belly 
below the bathtub to help retain heat in the bath water. 
Typically, insulation is blown into the belly through holes cut in the belly 
wrap. If necessary, reinforce the belly with lath strips and long screws. 
Reinforcing the belly will also reduce the volume, resulting in fewer bags 
of insulation needed to fill the belly section. 

134 Manufactured Home Energy Audit 



Belly Insulation-Loose Fiberglass 
Fill belly with loose insulation. 

Caution: 
Use a f l l  tube thQt minimizes buildup of static electricity and 
dkchrge it frequently. 

This retrofit measure is evaluated if the depth of the existing 
insulation in the belly section is less than the average belly depth. 
The benefit from filling the belly with loose insulation is threefold 1) 
the R-value of the floor section is increased; 2) if the duct is located 
under the floor, the duct distribution loss is decreased (resulting in an 
increased furnace delivery efficiency); and 3) the floor of the 
manufactured home remains warm in the winter, increasing occupant 
comfort. Be sure to repair holes in the belly, repair openings in the 
floor, and seal the duct (if located under the floor) before blowing 
insulation into the belly section. Also, be careful that there is at least 
2 inches of insulation under pipes located in the belly section and do 
not to insulate above water pipes. Finally, insulate the belly below the 
bathtub to help retain heat in the bath water. 
Typically, insulation is blown into the belly through holes cut in the 
belly wrap. If necessary, reinforce the belly with lath strips and long 
screws. Reinforcing the belly will also reduce the volume, resulting 
in fewer bags of insulation needed to fill the belly section. 

Roof Insulation-Loose Cellulose 
Fill roof with loose insulation. 
Caution: 

Use ajill tube that minimizes buildup of static electricity and 
dkchurge it frequently. 

This retrofit measure is evaluated if the existing insulatable space in 
the roof section is greater than 2 inches. The benefit from filling the 
roof with loose insulation is twofold. The R-value of the roof section 
is increased and if the duct is located above the ceiling, the duct 
distribution loss is decreased (resulting in an increased furnace 
delivery efficiency). Be sure to repair holes in the roof, repair 
openings in the ceiling, and seal the duct (if located above the ceiling) 
before blowing insulation into the roof section. If necessary, also 
reinforce the ceiling of the home with rosettes or wood lath strips and 

. long screws before blowing insulation into the roof section. 
Typically, insulation is blown into the roof section through holes cut 
between the roof joists in either the roof or the ceiling. 
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Roof Insulation-Loose Fiberdass 
Fill roof with loose insulation. 

Caution: 
Use ajZ1 tube that minimizes buildup of static electricity and 

This retrofit measure is evaluated if the existing insulatable space in the 
roof section is greater than 2 inches. The benefit from filling the roof with 
loose insulation is twofold. The R-value of the roof section is increased 
and if the duct is located above the ceiling, the duct distribution loss is 
decreased (resulting in an increased furnace delivery efficiency). Be sure 
to repair holes in the roof, repair openings in the ceiling, and seal the duct 
(if located above the ceiling) before blowing insulation into the roof 
section. If necessary, also reinforce the ceiling of the home with rosettes 
or wood lath strips and long screws before blowing insulation into the 
roof section. Typically, insulation is blown into the roof section through 
holes cut between the roof joists in either the roof or the ceiling. 

. discharge 2fiequently. 

Add Skirting 
Install exterior skirting. 
This retrofit measure is evaluated only if no exterior skirting exits. The 
benefit from installing exterior skirting is to slightly increase the R-value 
of the floor section. Exterior skirting typically does not significantly 
decrease the energy consumption of the home. 

White Coat Roof 
An elastomeric, low-emmissivity roof-coating retrofit measure is applied 
only to homes with either a bowstring roof or flat roof, dark roof color, 
and which have an existing cooling system. The benefit is to decrease the 
solar load on the roof, which in turn decreases the home cooling load. 
This retrofit measure is commonly installed in cooling climates. 

Redace Exterior Doors 
This retrofit measure is evaluated only if the existing door is not a 
standard manufactured home door. The benefit assigned to this measure 
is to increase the R-value through the door. Typically, replacing 
manufactured home doors does not si,onificantly reduce the overall 
heating and cooling loads. If the door flange is damaged so that a tight 
seal around the closed door cannot be made, then the door may need 
replacing. This is a situation that cannot be detected by MHEA. 
Replacing the door under this circumstance is a judgment made by the 
auditor and installed under the general air- sealing retrofit measure or as a 
home repair. 
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Add Exterior Storm Doors 

This retrofit measure is evaluated only if there is not an existing storm 
door. The effect of adding a storm door is to slightly increase the R- 
Value of the storm door/manufactured home door combination. Storm 
doors seldom significantly affect the energy consumption of the 
manufactured home. 

Redace Windows 

Replace single-glaze windows. 
The advantage of replacing single-glazed windows with double-glazed 
windows is evaluated for this retrofit measure. The measure is not 
applied to sliding glass door or door windows. The benefit is to decrease 
the window U-value and to decrease the solar transmittance (which in 
turn decreases the solar load). 

Add Plastic Storm Windows 
Add interior plastic film storm windows. 
This retrofit measure is evaluated if storm windows do not exist. The U- 
value of the storm window/window combination is decreased when this 
retrofit measure is applied. MHEA assumes that interior plastic film 
storm windows are used only during the heating-dominated months. 
Interior plastic storms may either be purchased or can be fabricated using 
a acrylic window film cut to the size of the window and held in place with 
magnetic strips or Velcrom. 

Add Glass Storm Windows. 
Add interior glass storm windows. 
This retrofit measure is evaluated if storm windows do not exist. The U- 
value of the storm window/window combination is decreased when this 
retrofit measure is applied. MHEA assumes that interior glass storm 
windows are used only during the heating-dominated months. 

Add Awnings 
Add exterior window awnings. 
This retrofit measure is applied to all windows without existing awnings 
except north-facing windows. The measure increases the shade on the 
windows, which decreases the solar load. 

Add Shade Screens 
Add exterior fabric mesh window sun screen shades. 
This retrofit measure is applied to all windows without existing sun 
shades. The measure increases the shade on the windows, which 
decreases the solar load. 
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Setback Thermostat 
Install automatic setback thermostat. 
This retrofit measure is evaluated if the indoor dayhight temperature 
difference is less than 5' F and the heating night temperature is greater 
than 60' F or the cooling night temperature is less than SO0 F. The retrofit 
measure is only applied if the heating andor cooling systems are 
controlled from a central thermostat. The night heating thermostat 
setpoint is decreased by 5' F and the cooling night thermostat setpoint is 
increased by 5' F with this retrofit measure. If an automatic setback 
thermostat is installed, it is advised that you instruct the occupant as to 
how to properly set and operate the thermostat. 

Tune-uD Heating System 
Tune-up heating system, natural gas, oil, propane, kerosene. 

Caution: 
Work should only be conducted by qualified personnel. 

Identifying opportunities for increasing furnace delivery efficiency and 
safety can be accomplished quickly by trained personnel. For example, 
comparing the air temperature at the return air intake and the closest 
heating register for 5 minutes with the fan on can help determine potential 
problems. Excessive heat rise may indicate insufficient air flow because 
of a dirty or faulty blower, a clogged filter, duct blockage, or an. oversized 
fuel jet. .A small heat rise may indicate duct leaks, undersized blower, 
dirty filter, needed adjustment or replacement of fan odoff switches, 
needed adjustment of the thermostat anticipator, and in the case of 
combustion furnaces, a clogged fuel line or faulty fuel valve. 
Servicing a manufactured home furnace should include but is not limited 
to cleaning out duct blockage and repairing duct leaks (if not already 
completed as a duct-sealing retrofit measure), cleaning the blower, 
cleaning the heat exchanger (check for cracks), replacing the filter, 
replacing or adjusting fan odoff  switches, and adjusting the thermostat 
anticipator. Refer to state weatherization office guidelines for servicing 
furnaces. 
Typical sealed combustion furnaces found in manufactured homes will 
have a combustion air duct that either supplies combustion air from 
underneath the furnace through a duct that penetrates the belly and floor 
or supplies combustion air to the top of the furnace by way of a downdraft 
air channel fabricated as part of the flue. Check that the combustion air 
inlets are properly sealed. No other combustion air sources are needed if 
the combustion path is sealed properly and if the heat exchanger is in 
good condition. 
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For health and safety reasons, it is recommended that basic safety checks 
for carbon monoxide, spillage, backdrafting, flame color, and cracked 
,heat exchangers are done after any work on a combustion furnace has 
been completed. 
Tune-up heating system, electric, heat pump. 
Identifying opportunities for increasing furnace delivery efficiency and 
safety can be accomplished quickly by trained personnel. For example, 
comparing the air temperature at the return air intake and the closest 
heating register for 5 minutes with the fan on can help determine potential 
problems. Excessive heat rise may indicate insufficient air flow because 
of a dirty or faulty blower, a clogged filter, or duct blockage. A small 
heat rise may indicate duct leaks, undersized blower, dirty filter, needed 
adjustment or replacement of fan odoff  switches, or needed adjustment of 
the thermostat anticipator. 
Servicing a manufactured home furnace should include but is not limited 
to cleaning out duct blockage and repairing duct leaks (if not already 
completed as a duct-sealing retrofit measure), cleaning the blower, 
replacing the filter, replacing or adjusting fan odof f  switches, and 
adjusting the thermostat anticipator. Refer to state weatherization office 
guidelines for servicing furnaces. 

Replace Heating System 
This retrofit measure is evaluated if the existing primary heating system is 
not fueled by coal or wood. The efficiency of the system is increased 
with a new furnace. Because of the high cost of a new furnace, this 
retrofit measure is typically not recommended. 

Evauorative Cooling 
Replace DX cooling system with evaporative cooler. 
This retrofit measure evaluates the benefit of replacing an existing DX 
cooling system with an evaporative cooler if the existing primary cooling 
equipment is a central system or a room air conditioner with a COP of 
less than 3.5. In dry climates, an evaporative cooler can be quite 
comfortable. Usually, an evaporative cooler consumes only about 25% of 
the energy consumed by central air conditioners. 

Tune-up Cooling Svstem 
This retrofit measure is applied to all cooling systems. The cooling 
capacity of the cooling equipment is increased as a result of tuning the 
system. Evaporative cooler tune-ups may include cleaning the fan blades, 
scraping scale off the louvers in the cooler cabinet, cleaning the water 
trough, replacing the motor with a high-efficiency motor, change out 
pump controls, and add new pads. DX system tune-ups may include 
cleaning the coils, filters, fan blades, grilles, motors, compressors, and 
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controls as well as adding a few drops of 20 weight electric motor oil to 
the motor and fan bearings. If the cooling equipment supplies air through 
the heating-supply duct, check that the damper that prevents heated air 
from flowing into the cooling equipment during the winter operates 
properly. 

Redace Cooling. System 
This retrofit measure is evaluated if the existing primary cooling system 
is a central air conditioner, heat pump, or room air conditioner. The 
cooling capacity of the system is increased with a new air conditioner. 
Because of the high cost of a new air conditioner, this retrofit measure is 
typically not recommended. 
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Appendix C 
Common Questions 

Q - I installed MHEA but nothing happens when I type MHEA to start the software. 
A - Be sure that you are in the correct directory before typing the MHEA command 
to start the software. The software installation procedure creates a directory called 
MHEA. A prompt such as C : W A  must appear on your screen before you type 
the command MHEA. If you have installed the software into a directory other than 
the default directory, then a prompt such as C:\<directory name>\MHEA must be on 
your screen before typing the command =A. If you had a previous version of the 
software on your computer before installing a new MHEA version, you may have 
accidentally installed the software into an existing directory that is named MHEA. If 
this is the case, you should have a prompt on your screen such as C : W A W A  
on your screen before typing the MHEA command. Refer to section 1.2, Installing 
MHEA, and Section 1.4.1, Starting MHEA, for more detail on how to install and 
start MHEA software. 

Q - When I ran MHEA calculations for the first time after installing the software, a 
message appeared saying "Could not find weather data." What does this mean? 
A - When you initially install MHEA software, there is not a default weather data 
location. You must go into the Weather Data submenu item found within the Setup 
menu and select a state and city. After choosing a weather data location, select the 
Reset Defaults Data button to make that city the default city. After a default city 
has been identified, you are not required to complete the "Weather Data Site" screen 
before running calculations for future project files unless you wish to change the 
weather data location. See Section 4.7, Choose a City, to learn more about selecting 
a weather data location. Also, refer to Section 1.3, Navigating Through MHEA, to 
learn how to work through the MHEA "Weather Data Site" screen. 

Q - My mouse does not work with MHEA but it does work with all my Windows@ 
applications. 
A - MHEA is an MS-DOS@ application. Your mouse may be configured correctly 
for Windows@ but not configured correctly for MS-DOS@,. Refer to your MS- 
DOS@ user manual to learn how to configure your mouse for MS-DOS@ 
applications. 

Q#b Is there anything I can do to reduce the calculation time for MHEA? 
A - The time that it takes MHEA to complete its calculations can be significantly 

effected by the setup of your computer. In general, you should be sure that disk 
caching is enabled if it is available on your system. Seek assistance from your 
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local computer staff if you are unsure how to determine if this feature is 
available to you. Eliminating retrofit options that are not considered in your 
region from the candidate measure list is also beneficial. 

Request of the User 
Any piece of software is improved by user comments. We do want to hear 
from you if you have suggestions or questions. However, certain kinds of 
problems related to the configuration of your computer are difficult to 
diagnose at a distance and are best handled locally at your site. If you are 
having problems making MHEA work with your mouse, for example, but 
you are unsure how to correct the problem, we encourage you to refer to the 
user manuals that came with your computer and to consult with your onsite 
computer support staff. 
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Manufactured Home Energy Audit 
Field Data Input Worksheet 

Floor Joist Direction 
0 Len,otwise 

0 Widthwise 

General Information 
Client Name: 

Client Address: 

City, State: 

Zip Code: 

BMlanket  Direction Skirt 
0 Len,othwise 0 Yes 

0 Widthwise 0 No 

0 No Batt/Blanket Insulation 

Home Dimensions 
Len,d(ft): 

Width (ft): 

Interior Wall 
Height (ft): 

Floor Joist Size 
0 2" x 4" 

0 2" x 6" 

0 2" x 8" 

~~~~ ~ 

Other Costs 
Health & Safety ($): 

Insulation Typeflhickness (in): Insulation Location 
BattlBlanket: 0 Attached to Flooring 

Loose Fill: Attached to Floor Joist 

Repair ($): 

Miscellaneous ($): 

0 Include Other Costs in SIR 

Outdoor Water 
Heater Closet 
0 Yes 

0 No 

Home Leakiness 
0 Tight 

0 Medium 

0 Loose 

Audit Date: 

Auditor: 

Job No.: 

Wind Shielding 
0 Well Shielded 

Normal 

0 Exposed 

Blower Door Test at 50 Pa 
Pre-Duct Sealing (ch) :  

Post-Duct Sealing (cfm): 

Floor (Center) Description 

Floor Joist Size 
0 2" x 4" 

2" x 8" 

Condition of Belly 
0 Good 

Average 

0 Poor 

Insulation Type/Thickness (in): 
BattlBlanket: 

Loose Fill: 

Insulation Location 
0 Attached to Flooring 

CI Attached to Floor Joist 

Cl Draped Below Floor Joist 

Belly Cavity Configuration 
0 Square 

Rounded 

0 Flat 

Maximum Depth of 
Belly Cavity (in): 
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Manufactured Home Energy Audit 
Field Data Input Worksheet 

Wall Stud Size 
0 2" x 2" 

0 2" x 3" 

0 2" x4" 

0 2" x 6" 

Wall Ventilation 
0 Ventilated 

0 Not Ventilated 

Wall 

Insulation Type/Thickness (in): 
BatUBlanket: 

Loose Fill: 

Foam Core: 

Carpoflorch Roof Dimensions 
Lengh (fi): 

Width (fi): 

Roofl 

Roof Type 
0 Flat 

0 Bowstring 

0 Pitched 

Roof Color 
0 LightReflective 

0 Dark 

Percent Cathedral Ceiling (9%): 

JOB NO.: 

Orientation of One Long Wall 
0 North , 

0 south 

0 East 

0 West 

CarpodPorch Roof Orientation 
0 North 

0 south 

0 East 

0 West 

*g 

Insulation TypeYllickness (in): 
Batt/Blanket: 

Loose Fill: 

Rizid Insulation: 

Orientation of cathedral Ceiling-step wall 
North 

0 south 

0 East 

West 

No Step Wall 



Manufactured Home Energy Audit 
Field Data Input Worksheet 

Description 
0 Jalousie 

0 Awning 

0 Slide; 

c] Fixed 

0 Door Winbaw 

Sliding Glass Door 

0 Skylight 

Interior Shading 
0 Drapes 

0 Blinds or Shades 

0 Drapes w/Shades 

0 None 

Description 
0 Jalousie 

Awning 

0 Slider 

0 Fixed 

0 Door Window 

0 Sliding Glass Door 

0 Skylight 

Interior Shading 
0 Drapes 

0 Blinds or Shades 

0 Drapes w/Shades 

0 None 

Window 

Glazing Type 
0 Single 

0 Double 

0 Single w/Glass Storm 

0 Double w/Glass Storm 

0 Single w/Plastic Storm 

0 Double w/Plastic Storm 

Exterior Shading 
0 Low E Film 

0 Sun Screen 

0 Awning 

0 Carport/Porch Roof 

0 None 

Window 

Glazing Type 
0 Single 

0 Double 

0 Single w/Glass Storm 

0 Double w/Glass Storm 

0 Single w/Plastic Storm 

0 Double wP1astic Storm 

Exterior Shading 
0 Low E Film 

0 Sun Screen 

0 Awning 

0 CarportlPorch Roof 

0 None 

JOB NO.: 
-~ ~~~ 

Dimensions 
Width (in): 

Len,& (in): 

Number of Windows 
for Each Orientation 
North: 

south: 

East: 

West: 

Dimensions 
Width (in): 

Len,* (in): 

Number of Windows 
for Each Orientation 
North: 

south: 

East: 

west: 

'I* - -  ,- ~ .-,+ , _.- - ., / .  



Manufactqed Home Energy Audit 
Field Data Input Worksheet 

nl 
Description 
0 Wood, Hallow Core 

0 Wood, Solid Core 

0 Metal, Vinyl, or Fiberglass Skin with Solid Core 

Dimensions 
Width (in): 

Height (in): 

DC 

Description 
0 Wood, Hallow Core 

0 Wood, Solid Core 

Metal, Vinyl, or Fiberglass Skin with Solid Core 

Dimensions 
Width (in): 

Height (in): 

~~ 

Description 
0 Wood, Hallow Core 

0 Wood, Solid Core 

0 Metal, Vinyl, or Fiberglass Skin with Solid Core 

Dimensions 
Width (in): 

Height (in): 

JOB NO.: 
rs 

Storm Door 
0 Yes 

No 

Number of Doors 
for Each Orientation 
North: 

south: 

East: 

s 

Storm Door 
0 Yes 

No 

Number of Doors 
for Each Orientation 
North: 

south: 

East: 

rs 

Storm Door 
0 Yes 

0 No 

Number of Doors 
for Each Orientation 
North: 

south: 

East: 

West: I 



Manufactured Home Energy Audit 
Field Data Input Worksheet 

JOB NO.: 
Heating E 

Heating Equipment Type 
0 Natural Gas Furnace 

0 Electric Furnace 

0 Elecmc Heat Pump 

0 Propane Furnace 

0 Oil Furnace 

0 Kerosene Furnace 

0 Coal Burning 

0 Wood Burning 

0 None 

Btu Capacity (kBtuh): 

Thermostat Setpoints: 
Day 0: 

Night 0: 

Secondary He; 

Heating Equipment Type 
0 Natural Gas Furnace 

0 Elecmc Furnace 

0 Electric Heat Pump 

0 Propane Furnace 

0 Oil Furnace 

0 Kerosene Furnace 

OCoalBurning . 

0 Wood Burning 

0 None 
Btu Capacity (kBtuh): 

uipment 

Heating Duct Location 
0 Floor 

0 Ceiling 

0 None 

Heating Duct Insulation Location 
0 Above Duct 

0 Below Duct 

El Around Duct or Ductboard 

0 No Insulation 

Percent of Total Heat Supplied (%): 

ng Equipment 

Heating Duct Location 
0 Floor 

0 Ceiling 

0 None 

Heating Duct Insulation Location 
0 Above Duct 

0 Below Duct 

0 Around Duct or Ductboard 

El No Insulation 



Manufactured Home Energy Audit 
Field Data Input Worksheet 

JOB NO.: 
Replacement He 

Heating Equipment Type 
I3 Natural Gas Furnace 

17 Electric Furnace 

I3 Electric Heat Pump 

I3 Propane Furnace 

I3 Oil Furnace 

0 Kerosene Furnace 

I3 Coal Burning 

I3 Wood Burning 

B& capacity (k~tuh): 

Replacement Heating Equipment 
0 Required 

I3 Not Required 

h g  Equipment 

Heating Duct Location 
0 Floor 

0 Ceiling 

None 

Heating Duct Insulation Location 
0 Above Duct 

I3 Below Duct 

0 Around Duct or Ductboard 

I3 No Insulation 

Replacement Costs Included with Home Retrofit Costs: 
0 Yes 

I3 No 
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Field Data Input Worksheet 

cooling 1 

Cooling Equipment Type 
0 Evaporative Cooler 

0 Central Air Conditioner 

0 Room Air Conditioner 

0 Heat Pump 

0 None 

Rated Total Capacity (Btuh): 

Rated COP: 

Average Indoor Temperatures: 
Day 0: 

Night 0: 

Secondary Cot 

Cooling Equipment Type 
0 Evaporative Cooler 

0 Central Air Conditioner 

0 Room Air Conditioner 

0 Heat Pump 

0 None 

Rated Total Capacity (Btuh): 

Rated COP: 

JOB NO.: 
pipment 

Cooling Duct Location 
0 Floor 

Ceiling 

0 None 

Cooling Duct Insulation Location 
0 Above Duct 

0 Below Duct 

0 Around Duct or Ductboard 

0 No Insulation 

Approximately Area of Home Cooled by Room Air 
Conditioner (%): 

ng Equipment 

Cooling Duct Location 
0 Floor 

Ceiling 

None 

Cooling Duct Insulation Location 
0 Above Duct 

0 Below Duct 

0 Around Duct or Ductboard 

0 No Insulation 
~ ~~ ~ 

Approximately Area of Home Cooled by Room Air 
Conditioner (%): 

-- . .” , 



Manufactured Home Energy Audit 
Field Data Input Worksheet 

Floor Joist Direction 
0 Len,ghwise 

Floor Dimensions 
Len=gh (ft): 

Width (ft): 

BanlBlanket Direction Skirt 
0 Lenghwise 0 Yes 

0 Widthwise 

Addition Orientation 
0 North 

0 south 

0 East 

0 West 

0 Widthwise 

0 No BattBlanket Insulation 

Interior Wall Height 
Maximum Height (ft): 

Minimum Height (ft): 

0 No 

Wall Stud Size 
0 y x 2 "  

0 2" x 3" 

0 2 " x P  

2" x 6" 

Floor Joist Size 
0 2" x 4" 

0 2'' x 6" 

0 2" x 8" 

Insulation TypeAXickness 
BanlBlanket (in): 

Loose Fill (in): 

Foam Core (in): 

Insulation Type/Thickness 
BattBlanket (in): 

Loose Fill (in): 

BanlBlanket Insulation Location 
Attached to Flooring 

0 Attached to Floor Joist 

Wall Confi,pation 
0 Maximum Wall Height at Interior 

Wall 

Maximum Wall Height in Center 
of Addition 

0 All Walls Same Height 

Wall Ventilation: 
0 Ventilated 

0 Not Ventilated 

RooflCeiling Joist Size: Roof Color 
0 2 " X 4 '  LightReflective 

0 2 " X C  Dark 

DYX8" 

Insulation Type/Thickness 
BanlBlanket (in): 

Loose Fill (in): 

' Rigid Insulation (in): 



Manufactured Home Energy Audit 
Field Data Input Worksheet 

Iescription 
0 Jalousie 

0 Awning 

0 Slider 

0 Fixed 

0 Door Window 

Sliding Glass Door 

0 Skylight 

hterior Shading 
0 Drapes 

0 Blinds or Shades 

0 Drapes w/Shades 

0 None 

Description 
0 Jalousie 

0 Awning 

0 Slider 

c3 Fixed 

0 Door Window 

0 Sliding Glass Door 

0 Skylight 

Interior Shading 
Cl Drapes 

0 Blinds or Shades 

0 Drapes w/Shades 

0 None 

Addition Window 

Glazing Type 
0 Single 

0 Double 

0 Single w/Glass Storm 

0 Double w/Glass Storm 

0 Single w/Plastic Storm 

0 Double w/Plastic Storm 

Exterior Shading 
0 Low E Film 

0 Sun Screen 

0 Awning 

0 Carportlporch Roof 

0 None 

Addition Window 
Glazing Type 
0 Single 

0 Double 

0 Single w/Glass Storm 

0 Double w/GIass Storm 

0 Single w/Plastic Storm 

0 Double w/Plastic Storm 

Exterior Shading 
0 Low E Film 

OSunScreen - 

0 Awning 

0 Carportlporch Roof 

0 None 

JOB NO.: 

Dimensions 
Width (in): 

Lengh (in): 

Number of Windows 
for Each Orientation 
North: 

south: 

East: 

West: 

Dimensions 
Width (in): 

Len,* (in): 

Number of Windows 
for Each Orientation 
North: 

south: 

East: 

west: 



~~ 

lescription 
0 Wood, Hallow Core 

0 Wood, Solid Core 

0 Metal, Vinyl, or Fiberglass Skin with Solid Core 

Dimensions 
Width (in): 

Height (in): 

Manufactured Home Energy Audit 
Field Data Input Worksheet 

JOB NO.: 
Addition Doors 

Storm Door 
0 Yes 

0 No 

0 No 

Number of Doors 
for Each Orientation 
North: 

south: 

East: 

West: 

0 Wood, Solid Core 

0 Metal, Vinvl, or Fiberglass Skin with Solid Core 

Dimensions 
Width (in): 

Height (in): 

Number of Doors 
for Each Orientation 
North: 

south: 

East: 

west: 

Addition Doors 
I 

Description 
0 Wood, Hallow Core 

Storm Door 
0 Yes 

3escription 
0 Wood, Hallow Core 

0 Wood, Solid Core 

0 Metal, Vinvl. or Fiberglass Skin with Solid Core 

Dimensions 
Width (in): 

Height (in): 

~~ 

Storm Door 
0 Yes 

0 No 

Number of Doors 
for Each Orientation 
North: 

south: 

East: 

West: 
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